IBM Systems - iSeries

Systems Management
Management Central

Version 5 Release 4







IBM Systems - iSeries

Systems Management
Management Central

Version 5 Release 4



Note
Before using this information and the product it supports, read the information in

Seventh Edition (February 2006)

This edition applies to version 5, release 4, modification 0 of IBM i5/0S (product number 5722-SS1) and to all
subsequent releases and modifications until otherwise indicated in new editions. This version does not run on all
reduced instruction set computer (RISC) models nor does it run on CISC models.

© Copyright International Business Machines Corporation 1998, 2006. All rights reserved.
US Government Users Restricted Rights — Use, duplication or disclosure restricted by GSA ADP Schedule Contract

with IBM Corp.




Contents

Management Central

What's new for V5R4

Printable PDF . .

Get started with Management Central
Before you begin .
Install Management Central
Set up the central system .
Troubleshooting Management Central
connections

Work with Management Central
iSeries Navigator monitors
Work with inventory .
Run commands with Management Central
Package and send objects with Management
Central .
Distribute fixes to multlple servers w1th 1Ser1es
Navigator .

© Copyright IBM Corp. 1998, 2006

0N WWN — =

.17
.17
. 35
. 37

. 38

. 39

Manage users and groups with Management

Central . . . 39
Share with other users in Management Central 41
Synchronize date and time values . .43
Synchronize functions . .43

Schedule tasks or jobs with Management Central
scheduler . . .44
Advanced Job Scheduler . . . . 45
Related information for Management Central .70
Code license and disclaimer information. .71
Appendix. Notices. . 73
Trademarks . .74
Terms and conditions . .75
iii



iv IBM Systems - iSeries: Systems Management Management Central



Management Central

Are you interested in making your system administration tasks simpler, easier, less time-consuming, and
much less repetitive? Are you looking to lower your overall total cost of server ownership? iSeries
Navigator provides the technology you need to do systems management tasks across one or more servers
simultaneously.

Click Management Central in iSeries Navigator to find easy-to-use systems management functions that
come to you as part of your base operating system. Management Central in iSeries Navigator allows you
to manage one or more systems through a single central system. Select a server to use as your central
system, then add endpoint systems to your Management Central network. You can create groups of
similar or related endpoint systems to make managing and monitoring your systems even easier. Your
central system will handle the communications for you. You can even take advantage of such options as
scheduling and unattended operations. You'll find that Management Central is flexible and easily
manipulated to suit your needs.

With iSeries Navigator for Wireless, administrators have even more flexibility in how they access and
interact with Management Central. The iSeries Navigator for Wireless overview contains tips on which
devices to use, how to install and configure the required elements, and a comprehensive overview of the
functions.

Related information

iSeries Navigator for Wireless overview]|

What’s new for V5R4

There are several new features in Management Central for V5R4.
Sharing

When you have a V5R4 GUI and a V5R4 Central system, you can share system monitors and system
events. You do this in the same way that you share job monitors, message monitors, and file monitors.
You specify the sharing level on the Sharing tab, which is located on the Properties window of the
monitor.

System monitor

Exclude heavily utilized communication lines, such as fax lines, from the system monitor graph. For
example, when you have two communication line utilization metrics, the average of all of the
communication lines is plotted. Thus, if there are one or more lines that you do not want to include in
the average, such as a line that is heavily loaded because of fax traffic, you can optionally exclude these
lines. For instructions on how to do this, use the online help for System Monitors. (From the System
Monitors Properties window click Help. From the help window click Help Topics. From the
Management Central Help Topics window, click Contents > How To » System Monitors » Excluding
communication lines from a system monitor.)

System monitor and graph history enhancements

Enhancements have been made to graph history and the system monitor.
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Table 1. What's new in Management Central for V5R4

SAVE You can now save a screen capture of the Graph History or the Systems Monitor
window (or just the selected graph) to your local drive. File > Save Window As,
File » Save Graph As

PRINT You can print your graphs from the Graph History or System Monitor window.
You can print the entire window, or just the selected graph. File » Print

COORDINATE The System Monitor has the ability to link all of the displayed graphs together.
When this option is selected, all of the graphs that make up the monitor will be
coordinated in terms of the time-slice shown, and the scroll position in the graphs.
Thereafter, if you scroll to one position in the graph, all of the graphs in the
monitor will simultaneously scroll to that same position. View » Coordinate

ORGANIZE Move the graphs in the System Monitor window into any visual configuration that
you want by drag and drop, and resizing the graphs. When you close the Systems

Monitor window, the size and positions of the graphs are saved. The next time you
open the window, the graphs will display in that configuration.

VISUALIZE Change the colors of the lines on the graph by using a menu option on the Graph
History and System Monitor windows. View » Set Monitor Colors

How to see what’s new or changed

To help you see where technical changes have been made, this information uses:
e The ¥ image to mark where new or changed information begins.
* The 4% image to mark where new or changed information ends.

Printable PDF

Use this to view and print a PDF of this information.

To view or download the PDF version of the Management Central topic, select[Management Central|
(about 810 KB)

You can also view or download a PDF version of specific sections of the Management Central Topic.
* [Getting started with Management Central| (about 234 KB)

* [Work with monitors| (about 194 KB)

+ [Advanced job scheduler|(about 313 KB)

You can view or download these related topics:

. (about 1100 KB) contains the following topics:

— Collection Services
— System monitors, job monitors, message monitors, file monitors

* Boftware and licensed programg (about 350 KB) contains the following topics:

— Fixes
— Product packaging
— Licensing

Saving PDF files

To save a PDF on your workstation for viewing or printing:
1. Right-click the PDF in your browser (right-click the link above).
2. Click the option that saves the PDF locally.
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rzaih.pdf
rzaihgetstarted.pdf
rzaihmonitor.pdf
rzaihajspc.pdf

3. Navigate to the directory in which you want to save the PDFE.
4. Click Save.

Downloading Adobe Reader

You need Adobe Reader installed on your system to view or print these PDFs. You can download a free

copy from the [Adobe Web site| (www.adobe.com/products/acrobat/ readstep.html)--lzjr .

Get started with Management Central

To get the most out of Management Central, set up your central system and endpoint systems in a way
that makes sense for your business environment. When you have finished these preliminary steps, you
are ready to start working with Management Central.

Printable PDF of the section, [Get started with Management Central| (about 234 KB)
Related information

[[nstall iSeries Navigator]|

Before you begin

This topic series contains information to help you complete a smooth installation and a successful
connection to Management Central. It is strongly recommended that you review all of the information in
this series before you being the installation process.

Related information

iSeries Navigator service web site]

[Setting the time zone before upgrading]

[Experience report: Configuring Management Central Connections for Firewall Environments|

CP/IP setup

[TCP/IP troubleshooter]
Configure TCP (CFGTCP) prerequisite check list

To ensure a smooth installation and setup of Management Central, you must make sure that the
environment is properly prepared. Use the check list in this topic to make sure that everything is ready
before you begin installing Management Central.

Prerequisite checklist

1. Your iSeries is current with the latest fixes, service packs for the client, and Java PTF group.

2. Read the Frequently Asked Questions at the Navigator service web site.

3. Use the QTIMZON system value to set the Java time zone for any system that is OS/400® V5R2 or

earlier. (This is because in any systems V5R3 or later the QTIMZON system value is used for the Java
time zone.)

4. Load all clients with iSeries Navigator and the latest service packs. (The release of the client may be at
a higher release than the central system.)

5. Determine the IP address of all of the clients that you will be using. If the client has multiple IP
address, it might be necessary to set the IP address to be used so that the central system can connect
back to the PC. In such a situation, setting the value for QYPS_HOSTNAME in the
MgmtCtrl.properties file will identify the IP address to be used. The following steps can help you
decide which IP address will work. To do this use the IPCONFIG command from a DOS prompt.
Write the addresses down for future reference.

a. Confirm a valid connection from the PC to the central system. Use the ping command (ping
xx.XX.XX.xX, where x=the IP address of the central system) on the PC.

b. Run IPCONFIG from the command prompt on the PC and record all of the IP Addresses.
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c. From the central system, ping each IP Address.
d. For the first IP address that works, create the file C:\MgmtCtrl.properties file and add this line:
QYPS_HOSTNAME==<ip address on which you performed the ping>.

6. If you are upgrading iSeries Navigator from a previous release, close all open iSeries Navigator
windows that might be open and exit iSeries Navigator. Start iSeries Navigator and try to connect to
the central system.

Management Central connection considerations

Understanding how Management Central establishes a connection is an important contributing factor
toward a successful installation and setup. Whether your system configuration is complex or simple there
are many considerations that affect a successful connection.

How Management Central establishes a connection

When the Management Central Java server (QYPSJSVR) starts it obtains the IP address for itself, by long
name (system + domain name), from TCP/IP. Typically, the clients that appear under My Connections
and the Management Central endpoints are defined by the system name or short name.

The iSeries Navigator lookup frequency default is Always. This setting causes a system that is listed
under My Connections to use the DNS or the TCP/IP host table (Configure TCP/IP (CEFGTCP) option 10)
to determine the IP address so that it can connect to the central system. The Host Name Search Priority
(Configure TCP/IP (CFGTCP) option 12) option controls how the DNS search is done. If it is *LOCAL, it
will search the TCP/IP host table first. If it does not find it there, it will use the DNS. If it is *REMOTE,
then the DNS is searched first, followed by the TCP/IP host table.

Connection timeout delay

When the Management Central servers on an endpoint are not running, a connection failure happens
right away. However, if the system is down or if a bad IP address is being used, the connection cannot be
made and there will be a several minute timeout delay before the connection failure is posted.

Connection tests

Management Central uses the IP address of the system located under My Connection to connect to the
Central System. When Management Central performs a connection test it does a ping on the PC of the
name that is being used for the Central System (typically short name) and then it returns the same IP
address as a Ping on the Central System by the long name. If this is not successful, then the client cannot
connect with the Java server. You can resolve this by overriding the Central System’s IP address.

To override the IP address on the Central System use the following character-based command:
CALL PGM(QSYS/QYPSCONFIG) PARM(xxxx 'y.y.y.y')

Where xxxx is the setting QYPSHOSTNAME and y.y.y.y is the value of the IP address to be used.
Important: Edit the file using the character-based interface. Do not use a mapped drive, or other method.
Lookup frequency

The system environment variable QYPS_DNS sets the Management Central lookup frequency (values 0 =
Never, 1 = Always). You can set the QYPS_DNS system variable by using one of these methods:

* Management Central properties window

* The Connection tab on the client

* Use the character-based interface to add an environment variable
CALL PGM(QSYS/QYPSCONFIG) PARM(xxxx 'y')
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Where QYPS_DNS is the setting and y is the value 0 or 1.

It is recommended that the lookup frequency is set to Always. When the lookup frequency is set to
Always, the IP address in the properties of the endpoint is ignored and a request for the IP address via
the DNS or the Host Table on the central system is made. As a result, if IP addresses are changed or if
the DNS or host table is changed, the new IP address is automatically picked up by Management Central.

When the lookup frequency is set to Never, the IP address that is contained in the properties of the
endpoint object is used. As a result, it is possible that a client can successfully connect to the central
system which uses the IP address that is determined by the My-Connection, but then have a task run to
the central system and have a connection failure. Such an event indicates that the Management Central
lookup frequency is set to Never and that the IP address in the endpoint for the central system is
incorrect. To resolve this situation, edit the IP address for the endpoint on the endpoint properties
window.

Note: The Management Central lookup frequency is a different setting than the lookup frequency setting
for a system under My Connections.

Connecting to a Java server

When a client connects to a Java server, the Java server uses an authentication procedure that connects
back to the PC. Therefore, the central server must be able to ping the PC.

A common connection problem occurs when the PC’s address is one that is reserved for private networks
(such as when an individual uses VPN from home to gain access to their network behind their router).
For example, assume the PC’s address is 10.100.46.143 and the IP address of the central system is
164.143.28.82. A connection failure occurs because addresses that start with 10 are not forwarded by
routers. In such a situation, you need to find out what the external IP address of the PC is and then set
up a client C:\MgmtCtrl.properties file, and then add the line QYPS_HOSTNAME=xxX.XXX.XXX.XXX
(where the xxx’s are the external IP address of the PC). This causes the Java server use the IP address
specified in the properties file to connect to the PC.

Management Central bulk data transfer considerations

A bulk transfer is a function that is used in Management Central to transfer data from a source system to a
target system (such sending of a package, sending PTFs, and so on). For a successful transfer, the target
system needs to be able to connect back to the source system. The IP address that is used on the target
system is determined by the lookup frequency on the target system. If the lookup frequency is Never
then the IP address that is used is the one that is provided by the central system for the source system. If
the lookup frequency on the target system is set to Always then it will use DNS or the host table to
determine the IP address of the source system.

Running Management Central tasks from My Connections

Some of the iSeries Navigator functions use Management Central to obtain information. For example, you
can view PTFs that are in Inventory by using My Connections » Configuration and Service. If
Management Central cannot connect to the central system then the function that you are trying to access
will experience a several minute time out delay. This results in a connection failure message. A good
practice to follow is to expand Management Central before you attempt to run any Management Central
functions that are located under My Connections. By doing so, you will make sure that you can connect
to the central system.

To run a Management Central task on a system in My Connections, the system must also be defined as

an endpoint under Management Central. To define a system as an endpoint expand Management Central
» Right-click Endpoint Systems > New Endpoint Systems.
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Install Management Central

After you have completed all of the prerequisite tasks, you are ready to install Management Central. This
topic series covers the installation steps as well as how the connection function works. If, after you have
installed Management Central, you fail to connect successfully, refer to the article series on trouble
shooting Management Central connections.

Why the highest release of Management Central is required

Each new release of Management Central contains updated functions, features and fixes that give
Management Central the ability to manage a system that has machines that are running different versions
of i5/0S™. In order to use these new features, you must have the most current release of Management
Central, and the Management Central dependencies.

Check for the most current MC code
You must have the most current Management Central server code, Management Central client code, and
Management Central dependencies before you can successfully use Management Central.

Check the Management Central servers for the most current code

The IBM® Software Technical Document|Recommended PTFs for Management Centrall document number
360059564, provides a summary of the recommended fixes by release.

To access this page from the IBM web page (www.ibm.com) follow this navigation path.
1. From the menu bar click Products.
2. From the Products page, under Servers, click Midrange (iSeries).

3. From the Midrange systems: iSeries page, on the navigation bar that is located on the left side, click
Support.

4. From the Support for iSeries family page, on the navigation bar that is located on the left side, click
iSeries support search.

5. Type in the document number in the Search for field and click Search.

Check the Management Central client for the most current code

The page provides up-to-date information about the service packs (fixes) for iSeries Access
for Windows®. To access this page from the IBM web page (www.ibm.com) follow this navigation path.

1. From the menu bar click Products.
2. From the Products page, under Servers, click Midrange (iSeries).

3. From the Midrange systems: iSeries page, on the navigation bar that is located on the left side, click
Software.

4. From the iSeries Software page click the Overview tab (if not already selected) and click iSeries
Software A-Z.

5. Under A, click iSeries Access.

6. On the iSeries Access page, on the navigation bar that is located on the left side, click Service Packs
(Fixes).
Related tasks
[‘Change the central system setup” on page 14|
You can select a different system as your central system at any time. The central system must be a

system to which you are directly connected. For the latest iSeries Navigator functions, your central
system should be running i5/0OS Version 5, Release 4 (V5R4).
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Steps for installing and accessing Management Central
Some of the systems management functions that you will want to use are optionally installable
components of iSeries Navigator, the graphical user interface (GUI) for iSeries servers.

When you choose the Typical option on the install wizard, the following Management Central functions
are installed.

* Tasks (inventory only)
* Endpoint systems
e System groups

If you did not install all of the components that you need when you installed iSeries Navigator, do the
following:

1. From the menu bar in iSeries Navigator, select File » Install Options » Selective Setup.

2. Use the Selective Setup wizard to install the additional components that you need for systems
management functions. To get all the systems management functions, select Configuration and
Service, Users and Groups, Commands, Packages and Products, and Monitors.

When you use the Selective Setup wizard, the components you select will be installed. Any
components you deselect during the selective setup will be uninstalled. Be careful not to accidentally
uninstall anything while you use the Selective Setup wizard.

When iSeries Navigator has been installed, double-click the desktop icon to start iSeries Navigator. You
are now ready to set up your central system.

Related information

iSeries Navigator]

[[nstall iSeries Access for Windows|

Verify the connection function

The Verify Connection function that is located under Management Central is different from the Verify
Connection function that is located under My Connection. This topic discuss the purpose of each function
and how they differ from each other.

Verify Connection from My Connection
My Connections » Right-click a server » Diagnostics » Verify Connection

This Verify Connection function pings the different host servers to see if they are up and running
correctly and can be reached from the PC. Since it is restricted to single system Navigator functions, it is
one of the first things you should rule out when you are troubleshooting a Management Central
connection failure. (Many Management Central functions build on the single system functions.) After you
have confirmed that the connection to the endpoint systems, under My Connections is successful, then
you can proceed to verify the connection from Management Central.

Verify Connection from Management Central
Right-click Management Central » Verify Connection

The Verify Connection function from the Management Central container is a diagnostic tool that checks
the most common factors that can cause a failed connection. It then displays the status of these tests. If it
reports any failures, you can obtain specific information about the failure as well as recovery information
by clicking Details. The following is a list of what Management Central verifies.

* The Java setup is correct on the Central System (This includes verifying that certain jar files are
present, and that certain integrated file system file and folder authorities have not been changed

Management Central 7



* The required files that were shipped with the operating system have not been deleted from the Central
System, are not damaged, and are being journaled

* The TCP/IP configuration on the Central System is valid (This includes verifying that the host name of
both the Central System and the PC are in the host tables or in the DNS as appropriate

 That a simple Navigator connection can be made to the Central System
e The VRM, host name, the IP address of the Central system, and the VRM of iSeries Navigator

* That the ports that Management Central uses are not in use by another application on the central
system

* That on the central system, the user profiles that are needed to run Management Central have not been
deleted, or disabled and that they have valid, unexpired passwords.

 That if SSL is being used on the central system, it is configured correctly and that both the PC and
central system are using SSL.

* That the central system isn’t marked as a "secondary system” in an Management Central High
Availability environment (Secondary systems cannot be used as central systems.)

¢ That the Management Central servers are up and running on the central system

* It reports what types of authentication are supported on the central system
Note:

iSeries Navigator uses the Java toolbox code on the client side (PC) to start the Management
Central Verify Connection function. If the toolbox code is not working correctly then the Verify
Connection function will not start. If the Java Virtual Machine (JVM) or the toolbox code on the
server side is not working correctly, the Verify Connection function will work until the last few
checks. The JVM must start before these last few checks can be performed.

Related information
[[BM Toolbox for Javal

Set up the central system

To manage multiple servers from a single system, you need to have a central system. After you have
installed Management Central and connected successfully, you are ready to set up the central system.

The servers in your network are called endpoint systems. You select one of these endpoint systems as your
central system. After you add endpoint systems to your network and select your central system, you only
need to do your system administration tasks once. Your central system will initiate your tasks and store
the necessary systems management data. You choose your central system when you first start iSeries
Navigator. You can also easily change your central system at any time.

Important: The release of the Central System must be the highest release in the network.

Set up your central system for the first time

To start using iSeries Navigator, double-click the desktop icon and select an iSeries server to connect to
and define an iSeries connection. The first server you specify is assigned as your central system.
Management Central appears automatically at the top of the list in the left pane of your iSeries Navigator
window. The Management Central server is automatically started on the central system.

To access the distributed systems management functions of iSeries Navigator, expand Management
Central.

For systems running i5/0S V5R3 and later, the Management Central databases are located in libraries

OMGTC and QMGTC2. For systems running releases earlier than i5/0S V5R3, the Management Central
databases are located in the QUSRSYS library.
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To complete an initialization, the Management Central sever requires that QSECOEFR is enabled and
active. If you use a different profile name with the same kind of authorization as QSECOF, you need to
run the following command on the central system.

CALL PGM(QSYS/QYPSCONFIG) PARM(QYPSJ SYSTEM ID 'XXXXX')
(xxxxx is a user ID other than the default of QSECOFR)

In some cases, the central system might have multiple IP addresses by which it can be accessed (CFGTCP
option 10). You can use a ping command on the central system to display the IP address that will be
returned to Management Central. If this is not the IP address that the clients use to connect to the system,
you can override the default IP address with the address that the ping command displayed. You can use
the following command to override the default IP address.

CALL PGM(QSYS/QYPSCONFIG) PARM(QYPS_HOSTNAME 'w.x.y.z')
(w.x.y.z is the IP address that Management Central should use for connection purposes)

If your central system is running OS/400 V5R2 or later (or V5R1 with PTF SI06917), you can right-click
Management Central and select Verify Connection to verify that the central system connection is
configured properly. To see detailed information about any Failed message, select the message and click
Details (or double-click the message).

Note: The Verify Connection function only confirms that Management Central is working properly on the
central system. TCP/IP configuration and firewalls also might prevent the Management Central
client from successfully connecting to the central system.

For more information about these and other Management Central tasks and topics, refer to the detailed
task help that is available from the iSeries Navigator window. Click Help from the menu bar and select
iSeries Navigator overview » Management Central.

Related information

[Experience report: Configuring Management Central Connections for Firewall Environments]
[TCP/IP troubleshooter]

CP/IP setup

Management Central settings and options

If you are migrating from a release that is earlier than V5R3, you should note that the system
environment variables were moved. This topic explains where you can find the client and server
environment variables for systems running a release of V5R3 or later.

/QIBM/UserData/0S400/Mgtc/Config/McCSConfig.properties

QYPS_EARLIEST_RELEASE
QYPS_MAXPTEF_SIZE
QYPS_FTP_DISCOVERY
QYPS_DISCOVERY_TIMEOUT
QYPS_DISC_LCLSUBNET
QYPS_SNMP_DISCOVERY
QYPS_IP_DISCOVERY
QYPS_DISCOVERY_STARTUP
QYPS_MAX_SOCKETS
QYPS_MAX_CONTIMOUT
QYPS_RETRY_TIMEOUT
QYPS_RETRY_INTERVAL
QYPS_AUTORETRY
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QYPS_SOCKETTIMEOUT
QYPS_COLLECTPTF_IFCHANGED
QYPS_DNS
QYIV_QUERY_MAX_SIZE
QYPS]_SAVF_RECORDS
QYPS]_TOOLBOX_TRACE
QYPS_LOCATION
QYPS_LOCATION2
QYPS]_CONNECT_INTERVAL

/Qibm/UserData/OS400/Mgtc/Config/McCSSecure.properties
(SSL setup)

QYPS_AUTH_LEVEL
QYPS_SSL

/Qibm/UserData/OS400/Mgtc/Config/McEPConfig.properties

QYPS_TRACE
QYPS]_TRACE
QYPS]_SYSTEM_ID
QYPS_MAX_TRANSFERS
QYPS_HOSTNAME
QYPS_MINIMUM_PORT
QYPS_MAXIMUM_PORT

/Qibm/UserData/OS400/Mgtc/Config/McEPSecure.properties

QYPS_USER_PASSWORD
QYPS_BASIC_AUTH
QYPS_TRUST_LEVEL
QYPS_KERBEROS_PRINCIPAL
QYPS_KERBEROS_CONFIG
QYPS]_SYSTEM_ID
QYPS_ID_MAPPING_ONLY
QYPS_USE_ID_MAPPING

Settings

iSeries Navigator allows you to manage multiple servers from a single system in a TCP/IP network
environment. Some aspects of your TCP/IP environment may require changes to your Management
Central server configuration. For example, if you are using a firewall or if you want to use SSL
encryption for Management Central server communications, you might need to change some of your
Management Central server settings.

Table 2. Management Central settings set via iSeries Navigator

iSeries Navigator Field
Name(Right-click Management
Central » Properties » Connection
Name Description Values tab)
QYPS_AUTORETRY Specifies whether to automatically | 0=No, 1=Yes Automatically restart monitors on
restart monitors on failed systems. failed systems
QYPS_COLLECTPTF_IFCHANGED | Update fixes inventory only if 0 =NO, 1 =YES; 0 is the default When collecting inventory, only
changes have occurred update when changes have
occurred
QYPS_DNS IP address lookup frequency 0 = Never, 1 = Always, IP address lookup frequency
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Table 2. Management Central settings set via iSeries Navigator (continued)

Name

Description

Values

iSeries Navigator Field
Name(Right-click Management
Central » Properties » Connection
tab)

QYPS_MAX_CONTIMOUT

Maximum time (in seconds) to wait
for a connection to a system to be
established

1 to 3600 (The default value is 180
seconds.)

While connected to endpoint
systems

QYPS_MAX_SOCKETS

Maximum number of sockets that
can be created on a system

200 (This is the default value.)

Maximum connections

QYPS_MAXPTF_SIZE

Maximum data transfer size

-1 = No maximum size

Maximum data transfer size (MB)

QYPS_RETRY_INTERVAL

Specifies how often (in minutes) to
attempt a monitor restart

5 (This is the default value.)

How often to attempt restart

QYPS_RETRY_TIMEOUT

Specifies how long (in minutes) to
attempt a monitor restart

180 (This is the default value.)

How long to attempt restart

QYPS_SOCKETTIMEOUT

Maximum time (in seconds) to wait
on a socket to return from a request

30 seconds (This is the default
value.)

When connecting to endpoint
systems

Table 3. Management Central settings set via character-based interface

Name

Description

Values

Use the character-based interface

QYIV_QUERY_MAX_SIZE

Maximum number of records in the
Inventory query

200

QYPS_HOSTNAME

The host name or IP address that
you want the endpoints and the PC
to connect to when they need to
make a new connection back to the
system.

Note: If you use a host name, then
you are relying on the endpoint or
the PC to resolve the host name
through their host table or DNS.

QYPS_LOCATION

Library name where the
Management Central databases are
found

QMGTC

QYPS_LOCATION2

Second library name where the
Management Central databases are
found

QMGTC2

QYPS_ID_MAPPING_ONLY

Indicates whether only the
Enterprise Identity Mapping (EIM)
should be used for authentication

0=No, 1=Yes

QYPS_MAXIMUM_PORT

Used by BDT (Bulk Data Transfer)
QYPSBDTSVR job . Minimum of
range of port number to be used.

QYPS_MINIMUM_PORT

Used by BDT (Bulk Data Transfer)
QYPSBDTSVR job . Minimum of
range of port number to be used.

Name of host server

QYPS_TRACE

C++ server tracing

-1 to turn Off; or 0 to turn On

QYPS_USE_ID_MAPPING

Java server tracing

-1 to turn Off; or 2 to turn On

QYPS]_CONNECT_INTERVAL

How often (in seconds) to do the
heartbeat to check connections.

60

QYPSJ_PORT

Port on which the Java server is
listening to for incoming client
requests

5544 (This is the default value.)

QYPS]J_SAVF_RECORDS

Maximum number of records in the
Java save file

100

QYPS]J_SYSTEM_ID

User profile with all object
authority

User profile which the Java server
runs as for certain tasks. This
profile must have *SECOFR class
authority. QSECOEFR is the default,
or you can specify the user profile
name.

QYPS]_TOOLBOX_TRACE

Indicates whether to turn Toolbox
trace on

0=0ff, 1=On
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Table 3. Management Central settings set via character-based interface (continued)

Name

Description

Values

Use the character-based interface

QYPSSRV_PORT

Port on which the C++ server is
listening to for incoming client
requests

5555. (This is the default value.)

QYPS]_TRACE

Port on which the C__ server is
listening to for incoming client
requests

Default 5555

Table 4. Management Central settings set via iSeries Navigator

iSeries Navigator Field Name
(Management Central » Right-click

Central server starts

Name Description Values Endpoint Systems + Properties)
QYPS_DISC_LCLSUBNET Discover local subnet 0=No, 1= Yes
QYPS_DISCOVERY_STARTUP Search every time the Management |0 = No, 1 = Yes

QYPS_DISCOVERY_TIMEOUT

Discovery timeout (in seconds)

15 (This is the default value.)

Timeout (seconds)

QYPS_EARLIEST_RELEASE

Earliest operating system release to
search for

V5R4MO, this is the default

Earliest operating system release to
search for

Network Mail Protocol

QYPS_FTP_DISCOVERY Run discovery using File Transfer |0 = No, 1 = Yes How to verify systems, FTP check
Protocol box

QYPS_IP_DISCOVERY Run discovery using Internet 0=No, 1= Yes
Protocol

QYPS_SNMP_DISCOVERY Run discovery using Simple 0=No, 1= Yes How to verify systems, SNMP

check box

The following table contains Property file (/Qibm/UserData/OS400/Mgtc/Config/McConfig.properties)
settings that you might need to change in order to accommodate your system’s needs. Unless it is
otherwise indicated, use the character-based interface to make these changes.

Table 5. Management Central property file parameters

Parameter

Description

Values

QYPS_SSL

Turns the Secure Sockets Layer
(SSL) on or off.

0=0ff,1=0n

iSeries Navigator Field
Name(Right-click Management
Central » Properties » Security tab)
Field name = Use Secure Sockets
Layer (SSL)

QYPS_AUTH_LEVEL

SSL authentication level. This value
works with the QYPS_SSL.

0 = off (This is the default. It can
only connect to a server without
SSL), 1 = Sever Authentication on
(This means it can connect to server
with or without SSL.)

iSeries Navigator (Right-click
Management Central > Properties
> Security tab) Field name =
Authentication level

QYPS_USER_PASSWORD

Require password on endpoint
systems

0=No, 1= Yes

iSeries Navigator (Right-click
Management Central > Properties
> Security tab) Field name = Use
profile and password authentication

QYPS]_SYSTEM_ID

The user profile with which the
Java Server runs as, for certain
tasks

QSECOER (This is the default
value.) You can also specify a user
profile name, however its profile

must have *SECOFR class authority.

Add endpoint systems to your Management Central network
An endpoint system is any system or logical partition in your TCP/IP network that you choose to
manage through your central system.

When you add a connection to a system from iSeries Navigator (by clicking File » Connection to Servers
> Add connection while your current environment is selected in the left pane), the system is added to the
list under your current active environment (typically named My Connections). Alternatively, when you
add a new endpoint system, the system name is added to the list of Endpoint Systems under

Management Central.
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When you perform an action on a system under My Connections, a direct connection from the client
(your PC) to the system is required, and actions are performed on one system at a time. In contrast,
Management Central allows systems management tasks to be performed on multiple systems (in the
Endpoint Systems list) and only one client connection (to the central system) is required.

The central system handles the connections to the endpoint systems. The Management Central property
setting for the Lookup Frequency controls how the IP address for an endpoint system is determined. If it
is set to NEVER then the IP address that is stored in the endpoint object is used. If it is set to ALWAYS,
then the TCP/IP, on the server provides the IP address for the system name that is specified.

Note: If you are adding endpoint systems that are running OS/400 V5R1, you must have the following
fixes (also known as PTFs) installed on the V5R1 system: 5101375, SI01376, S101377, SI01378, and
S101838. Without these fixes, you will not be able to use all the systems management functions on
the endpoint system.

To add one or more endpoint systems, do the following:
1. Right-click Endpoint Systems and select New Endpoint System.
2. Enter the name of the system and click OK.

The endpoint systems that you added appear automatically under Endpoint Systems in your iSeries
Navigator window. After you have added an endpoint system, you can view its properties. You can also
change the description or the IP address as needed.

Next, you can create system groups to help you manage different sets of endpoint systems. The new
system groups will appear under Management Central in iSeries Navigator.

For more information about these and other Management Central tasks and topics, refer to the detailed
task help that is available from the iSeries Navigator window. Click Help from the menu bar and select
iSeries Navigator overview » Management Central.

How to completely remove endpoints
This topic answers the question, "Why, when I delete an endpoint from Management Central, it later
reappears?”

When connecting to a target system, Management Central requires and uses endpoint objects.
Additionally, many Management Central functions appear under systems that are listed under My
Connections. Thus, whenever a user creates a system under My Connections, an endpoint object is saved
in the database on the central system as well as the client PC.

If you delete the endpoint from Management Central only the entry in the central system database is
deleted. You must also delete the system from all clients that have that system listed under My
Connections. Otherwise, the next time user, that still has that system listed under My Connections, starts
iSeries Navigator the endpoint will be automatically added again to Management Central

Therefore, to completely remove an endpoint that is also defined as a My Connection system, all users

that have the system defined must remove the My connection system so it will not be automatically
added.

Create system groups in your Management Central network

A system group is a collection of endpoint systems that you define. If you are working with multiple
systems or multiple logical partitions, creating a system group allows you to perform tasks on all the
systems without selecting each endpoint system. Just select the system group you created and start your
task.

Endpoint systems can belong to several system groups at the same time. After you have created a system
group, you can manage the entire group from your central system as if it were a single system.
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To create a system group, follow these steps:
1. Open Management Central from your iSeries Navigator window.
2. Right-click System Groups and select New System Group.

3. On the New System Group window, specify a unique name for the new system group. You can also
enter a brief description that will help you later identify this group in a list of system groups.

4. From the Available systems list, select the endpoint systems that you want to include in this new
group. Click the Add button to add the systems to the Selected systems list.

5. If you want to give other users the ability to view or change this system group, use sharing. Click the
Sharing tab and specify Read-only or Full sharing. If you specify None, other users will not be able
to view or change this system group unless they have special authority, which is administered under
Host Applications in Application Administration. Users with this special authority, called
Management Central Administration Access, can view all tasks, definitions, monitors, and system
groups under Management Central in the iSeries Navigator window.

6. Click OK to create the new system group.

The system group you create will include all the endpoint systems you entered. You may decide later that
you want to edit that list of endpoint systems. You can always add more endpoint systems or remove
endpoint systems from your system group.

You can delete system groups from Management Central. When you delete a system group or remove
endpoint systems from a system group, only the system group is changed. The endpoint systems that
were in the system group are still listed under Endpoint Systems in the iSeries Navigator window. If you
delete an endpoint system from the Endpoint Systems list, that endpoint system is removed from all
system groups.

For more information about these and other Management Central tasks and topics, refer to the detailed
task help that is available from the iSeries Navigator window. Click Help from the menu bar and select
iSeries Navigator overview » Management Central.

Related information

[Management Central and Application Administration|

Change the central system setup
You can select a different system as your central system at any time. The central system must be a system

to which you are directly connected. For the latest iSeries Navigator functions, your central system
should be running i5/0S Version 5, Release 4 (V5R4).

If your PC is running V5R2 or V5R3 iSeries Navigator, and you want to select a central system that is
running OS/400 V5R1, you must have the following fixes (also known as PTFs) installed on the V5R1
system: SI01375, S101376, SI01377, SI01378, and SI01838. Without these fixes, you will not be able to
connect to the V5R1 system as a central system.

To change your central system, follow these steps:
1. Right-click Management Central and select Change Central System.
2. Use the Change Central System window to choose a system from your list of connected systems.

3. If the system you want to use as your central system is not currently connected to your iSeries
Navigator network, right-click your active environment (typically "My Connections” ) and choose
Connection to Servers > Add connection. When the new system is connected, you can change your
central system to the new system.

After you have added endpoint systems and created system groups, those endpoint systems and system

groups will appear under Management Central as well. Once you have set up your central system, you
are ready to do the other tasks necessary for setting up Management Central.
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Important: The central system that you use should be equal to or at a later release than the releases of

the endpoints that are being used.

For more information about these and other Management Central tasks and topics, refer to the detailed
task help that is available from the iSeries Navigator window. Click Help from the menu bar and select
iSeries Navigator overview » Management Central.

Troubleshooting Management Central connections

Several factors can prevent a connection to the Management Central server. This topic contains a list of
steps that you can take to troubleshoot a failed connection.

First and foremost, make sure that the central system is running on the highest operating system release
in the network. Problems can occur because there are clients in the network that are running an operating
system that is at a higher release than the central system.

Related information

[Scenario: Secure all connections to your Management Central server with SSL

[Experience report: Configuring Management Central Connections for Firewall Environments|

[Digital Certificate Manager|

Failed connection to the central system

1.

From the PC, verify that you can ping your central system using the name or IP address listed in
iSeries Navigator as your central system. If this is unsuccessful then there is something wrong with
either your network, or your DNS or host table. You must fix this before you can connect.

From the central system, make sure that you can ping your PC using the IP address of your PC. If
this is unsuccessful, you will not be able to use some of the Management Central functions. For more
information, see the Information Center experience report, "Configuring Management Central
Connections for Firewall Environments”.

Verify the central system connection. (From iSeries Navigator expand My Connections » Right-click
the server that is your central system » Verify Connections. ) If this reports any errors, click Details.
This opens a window that displays information about what happened.

Use the Verify Connection function that is located under Management Central to further trouble shoot
the problem. (From iSeries Navigator right-click Management Central » Verify Connection. ) If this
reports any errors, click Details. This opens a window that displays information about what
happened.

What to do if you still cannot connect

If you still cannot connect use the following procedure to further troubleshoot the problem:

1.

Verify that the Management Central server QYPSJSVR is running on the Central System.

a. In iSeries Navigator, expand My Connections » server (that you are using as the central system)
> Network » Servers > TCP/IP.

b. Look at the Management Central item to see if the server is started. If necessary, right-click
Management Central under TCP/IP, and click Start.

c. If the server still fails to start, view the job logs for possible problems, or continue with the next
items to check for some common problems that can cause the servers not to start.

Check the TCP/IP configuration on the central system.

a. It is important that the Central System is able to ping itself using both the fully qualified domain
name and the short name. If pinging either of these names fails, you will need to add the name
and IP address to either the system’s host table or DNS. Make sure that the IP address used in
these pings is one that the PC can contact.

If you are using SSL with Management Central, verify that it is set up correctly. Make sure to

configure your Central System, all your endpoint systems, as well as iSeries Navigator on your PC.
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4.

5.

Check the QSECOER profile.

a. Management Central requires a profile with *ALLOBJ and *SECOFR authority enabled, and a
valid password must be set so that it does not expire.

Important: You must make this change via the character-based interface, otherwise the server
might not be able to read the file.

By default, Management Central uses the QSECOFR profile. Thus if this default has not been
changed, then you can enable QSECOEFR and set the password to never expire. (If you
choose not to set the password to never expire then you must be diligent about keeping the
password active. This is done by always changing the current password before it expires. ) If
you are using a customized profile other than QSECOEFR then enable it and set the password
to never expire. To change QSECOFR, open the properties file:
"/QIBM/UserData/0S400/MGTC/config/McConfig.properties”. Change the parameter
"QYPSJ_SYSTEM_ID = QSECOFR" to "QYPSJ_SYSTEM_ID = YOURPROFILE" (where
YOURPROFILE is the profile name replacing QSECOEFR).

b. Or you can run
CALL PGM(QSYS/QYPSCONFIG) PARM(xxxx 'yyyy')

where xxxx is QYPS]_SYSTEM_ID and yyyy is the name of the profile to be used.

If both of the Management Central servers on the central system are started successfully and you've
done the above troubleshooting, but you still can’t connect from iSeries Navigator, then most likely
the problem is either TCP/IP configuration related, or firewall related. In either case, use the
Configuring Management Central Connections for Firewall Environments experience report to
troubleshoot this problem. A few important notes are listed below:

* The Central System needs to be able to initiate a connection with iSeries Navigator on the PC, so it
is important that the Central System can ping the IP address of the PC.

¢ The PC needs to be able to initiate a connection with iSeries Navigator that is using the following
IPs:

— The name or IP being used as the central system name in iSeries Navigator (the name of the
system under my connections).

— The IP address that the central system gets when it pings itself.

Note: The initial connection to the central system uses the name or IP specified in iSeries Navigator
for the central system. However during this initial connection, the central system discovers
its own IP address and sends that IP to the PC. The PC uses that IP address for all further
communications. The ports that Management Central uses need to be open in any firewalls
that are being used.

Failed connection from PC to the central system

1.
2.
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Right-click Management Central and run Verify Connection.

Make sure that the single socket layer (SSL) for the Management Central servers is turned on. Look in
/qibm/userdata/0s400/mgtc/config/McConfig.properties and confirm that QYPS_SSL>1 or
QYPS_AUTH_LEVEL>1. If you change these values, remember to restart the Management Central
servers.

If you are running OS/400 V5R2, did the QYPSSRYV job fail to start? If it failed to start then the
Digital Certificate Manager (DCM) configuration was not done correctly. Make sure that you have
assigned your certificate the Management Central Application identification as well as the host server
IDs.

Is there a padlock icon next to the central system? If not, then the client is not using SSL to connect.
Under My Connections, right-click the central system, go to the Secure Sockets tab, and then choose
to use SSL. Then click OK. You must close iSeries Navigator and restart it before this value takes
affect.
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5. On that same Secure Sockets tab as mentioned in step 3, there is a button to Download the CA to
your PC. Make sure that you have done this, using the operating system that you CREATED the CA
on (not necessarily the central system).

6. On the same Secure Sockets tab mentioned in the above bullet, there is a Verify SSL Connection. Run
this and look at the results.

7. 1If you are running OS/400 V5R2 verify that the file
QIBM\ProdData\OS400\Java400\jdk\lib\security\java.security has the following properties defined
as these can cause a connection problem.

* 0s400.jdk13 jst.factories=true
¢ ssl.SocketFactory.provider=com.sun.net.ssl.internal.ssl.SSLSocketFactoryImpl

8. If you are running OS/400 V5R2 on the client, on your PC, look at c:\Documents and Settings\ All
Users\Documents\ibm\client access\classes\com\ibm\as400\access\KeyRing.class. Is it size 0? If so,
delete the file and download the Certificate Authority.

Failed connection from central system to endpoint

In addition to following the steps for troubleshooting a failed connection from the PC to the central
system, you should also view the job log on the central system. It should give a reason for why the
connection was rejected. (For example: (CPFB918) Connection to system mysystem.mydomain.com
rejected. Authentication level 0. Reason Code 99. This means that the SSL is not active for the endpoint.
Instead, it is at authentication level 0.) You can find the meanings for negative reason codes in
/QSYS.LIB/QSYSINC.LIB/H.FILE/SSL.MBR.

Note: Endpoint systems do not require a padlock.

Additional considerations

Firewall considerations
All communication is TCP initiated from the PC to the central system. You can specify the exact
port to use by adding the following line to the C:\MgmtCtrl.properties file:

QYPSJ_LOCAL_PORT=xxxx

where xxxx is the port number. The port number should be greater than 1024 and less than 65535.
Additionally, the port number must not be used by another application on the PC. The port must
be open through the firewall. Should the firewall require it, all sockets must be open.

Work with Management Central

After Management Central has been set up, you can use it to streamline your server administration tasks.

iSeries Navigator monitors

Monitors display current information about the performance of your systems. Additionally, you can use
them to carry out predefined actions when a specific event occurs. You can use the system, message, job,
file, and B2B transaction monitors to display and monitor information about your systems. The system
and job monitors use the performance data collected by Collection Services.

The monitors included in iSeries Navigator use Collection Services data to track the elements of system
performance of specific interest to you. Moreover, they can take specified actions when certain events,
such as the percentage of CPU utilization or the status of a job, occur. You can use monitors to see and
manage system performance as it happens across multiple systems and groups of systems.

With the monitors, you can start a monitor, and then turn to other tasks on your server, in iSeries
Navigator, or on your PC. In fact, you could even turn your PC off. iSeries Navigator continues
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monitoring and performing any threshold commands or actions you specified. Your monitor runs until
you stop it. You can also use monitors to manage performance remotely by accessing them with iSeries
Navigator for Wireless.

iSeries Navigator provides the following types of monitors:

System monitor
Collect and display performance data as it happens or up to 1 hour. Detailed graphs help you
visualize what is going on with your servers as it happens. Choose from a variety of metrics
(performance measurements) to pinpoint specific aspects of system performance. For example, if
you are monitoring the average CPU utilization on your server, you can click any collection point
on the graph to see a details chart that shows the 20 jobs with the highest CPU utilization. Then,
you can right-click any of these jobs to work directly with the job.

Job monitor
Monitor a job or a list of jobs based on job name, job user, job type, subsystem, or server type.
Choose from a variety of metrics to monitor the performance, status, or error messages for a job.
To work directly with a job, just right-click the job from the list that is shown in the Job Monitor
window.

Message monitor
Find out whether your application completes successfully or monitor for specific messages that
are critical to your business needs. From the Message Monitor window, you can see the details of
a message, reply to a message, send a message, and delete a message.

B2B activity monitor
If you have an application like Connect for iSeries configured, you can use a B2B activity monitor
to monitor your B2B transactions. You can view a graph of active transactions over time, and you
can run commands automatically when thresholds are triggered. You can search for and display a
specific transaction as well as view a bar graph of the detailed steps of that specific transaction.

File monitor
Monitor one or more selected files for a specified text string, for a specified size, or for any
modification to the file.

To find out more about monitors, see the following topics:

Monitor concepts

Monitors can display real-time performance data. Additionally, they can continually monitor your system
in order to run a selected command when a specified threshold is reached. Learn how monitors work,
what they can monitor, and how they can respond to a given performance situation.

The system monitors display the data stored in the collection objects that are generated and maintained
by Collection Services. The system monitors display data as it is collected, for up to one hour. To view
longer periods of data, you should use Graph history. You can change the frequency of the data collection
in the monitor properties, which overrides the settings in Collection Services.

You can use monitors to track and research many different elements of system performance and can have
many different monitors running simultaneously. When used together, the monitors provide a
sophisticated tool for observing and managing system performance. For example, when implementing a
new interactive application, you might use a system monitor to prioritize a job’s resource utilization, a
job monitor to watch for and handle any problematic jobs, and a message monitor to alert you if a
specified message occurs on any of your systems.

Setting thresholds and actions

When you create a new monitor, you can specify actions you want to occur when the system metric
reaches a specified threshold level, or an event occurs. When threshold levels or events occur, you can
choose to run an i5/0S command on the endpoint systems, such as sending a message or holding a job
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queue. Additionally, you may choose to have the monitor carry out several predefined actions such as
updating the event log and alerting you by either sounding an alarm on your PC or launching the
monitor. Finally, you can automatically reset the monitor by specifying a second threshold level which
causes the monitor to resume normal activity when it is reached.

Job monitors and Collection Services
In order to avoid creating a negative performance impact on your system, you should understand how
the different metrics in the job monitor uses Collection Services.

The metrics that are available for a job monitor are:
* Job count

* Job log message

* Job status

* Job numeric values

¢ Summary numeric values

The data for the job numeric and summary numeric values metrics come from Collection Services. The
overhead for obtaining this data is minimal and is not affected by the number of specific jobs that are
being monitored. It takes two intervals of Collection services data before the first point or data metric
value can be calculated. For example, if the collection interval is 5 minutes it will take more than 5
minutes before the first metric value is known.

The overhead for the job log message and job status metrics is much more costly in terms of the CPU
resources required to obtain the information. Additionally, the number of jobs that are being monitored as
well as the collection interval, affect the amount of CPU overhead that is required. For example, a job
Monitor with a 5 minute interval will have six times the amount of overhead process to complete versus
if the collection interval was set to 30 minutes.

Related information
[About Collection Services|

The QYRMJOBSEL job:

For every job monitor that runs, a QYRMJOBSEL job starts. This topic explains the purpose of the
QYRM]JOBSEL job and what causes it to end.

The QYRMJOBSEL uses the information that is specified in the General page of the Job Monitor
definition (Management Central » Monitors > Job » Right-click a monitor and click Proprieties) with
Collection Services data (QYPSPFRCOL) to determine what specific jobs need to be monitored. These jobs
are then shown in the bottom half of the Job Monitor status window.

Even if only one job is running, QYRMJOBSEL still examines all of the active job data from Collection
Services to determine how many jobs are running, if new instances have started or if instances that were
running during the previous interval have ended. The QYRMJOBSEL job does this analysis at each
interval. Thus, the amount of CPU resource that is needed for QYRMJOBSEL to complete this function is
determined by how many active jobs are on the system. The more active jobs, the more jobs for
QYRMJOBSEL to analyze.

Additionally, the QYRMJOBSEL job registers with Collection Services the needed probe data, but it
cannot provide the notification interval. So it is always at the lowest interval at which Collection Services

is running. Thus, a smaller collection interval means that this processing is performed more frequently.

For example, suppose the job monitor server starts a job monitor at 5 minute collection intervals. Then
another monitor that is using Collection Services starts, but uses a smaller interval. As a result, the

Management Central 19



QYRM]JOBSEL receives the data at the smaller or more frequent interval. If the smaller interval is 30
seconds, there will be a 10 time increase in the amount of data QYRMJOBSEL processes, thereby
increasing the need for CPU resources.

When the job monitor is stopped, its associated QYRMJOBSEL job receives an ENDJOB immediate and
terminates with a CPC1125 Completion 50 severity. This is the normal way that the QYRMJOBSEL is
removed from the system.

Note: For QYRMJOBSEL to work properly, the Java time zone must be correctly set. This is done by
setting the QTIMZON system value.

QZRCSRYVS jobs and their impact on performance:

Job monitors connect to a QZRCSRVS job for each job that is being monitored for the Job Log Messages
and the Job Status metrics. The more jobs that are being monitored for these metrics, the more
QZRCSRVS jobs are used.

QZRCSRVS jobs are not Management Central jobs. They are i5/0S TCP Remote Command Server jobs
that the Management Central Java server uses for calling commands and APIs. In order to process the
API calls for the Job Log Messages and Job Status metrics in a timely fashion within the job monitor’s
interval length, the APIs are called for each job concurrently at interval time.

When both metrics are specified on the same monitor, two QZRCSRVS jobs are started for each job. For
example, if 5 jobs are monitored for Job Log Messages, 5 QZRCSRVS jobs are started to support the
monitor. If 5 jobs are monitored for Job Log Messages and Job Status, then 10 QZRCSRVS jobs are started.

Thus, it is recommended that for standard systems, when you are using the Job Log Message and Job
Status metrics, you limit the number of jobs monitored on a small system to 40 jobs or less. (With larger
systems more jobs may be monitored. However, you should have a clear understanding of the resources
that are used when monitoring more jobs and determine the affordable number to monitor. ) Also,
severely limit using these two metrics for monitoring subsystems, as doing so can cause a large number
of QZRCSRVS jobs to run. (A job monitor that uses just the other metrics and does not use Job Status or
Job Log Message, does not use QZRCSRVS jobs.)

Tuning QZRCSRVS jobs

For jobs that pass work to the QZRCSRVS jobs, the subsystem that is specified on the QWTPCPUT API
determines where the QZRCSRVS jobs run. QWTPCPUT is called during the processing of the QYSMPUT
APIL This API retrieves the subsystem information from the QUSRSYS/QYSMSVRE *USRIDX object and
uses it on the QWTPCPUT call. As shipped, QZRCSRVS jobs are prestart jobs that run in the QUSRWRK
subsystem and this is where the connections are routed.

If you end the prestart jobs in QUSRWRK with the ENDPJ command, then the QZRCSRVS jobs start as
batch-immediate jobs in the QSYSWRK subsystem whenever a connection is requested. No jobs start in
advance of the connection.

You can configure your system so that prestart jobs can be run from any subsystem. You can also
configure your system to prevent batch-immediate jobs from being used at all. If the Job Monitor server
jobs are calling Java Toolbox functions to pass work to QZRCSRVS, then they are using the QYSMPUT
API, and the work should run in whichever subsystem is stored in the user index.

QZRCSRVS cleanup

A cleanup thread runs once an hour to determine whether a QZRCSRVS job is still being used by a Job
Monitor. It determines if the job was used at least twice within the maximum job monitor interval length.
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If the job is not used during the previous two hours, it is ended. Java time stamps are used for this

comparison, so it is imperative that the time zone value used by Java is correct (system value
QTIMZON).

QZRCSRVS jobs are automatically removed two hours after the job it supports ends. Likewise
QZRCSRVS jobs will end if the Job Monitor that created them stops, or if Management Central ends.

Note: Since the Management Central Job Monitor monitors active jobs, you might see messages like
"Internal job identifier no longer valid” in the QZRCSRVS job. This normally happens when a
monitored job with Job Log Messages or the Job Status metric ends while the monitor is running.

Create a new monitor

Creating a new monitor is a quick and easy process that begins at the New Monitor window. In iSeries
Navigator, expand Management Central, expand Monitors, right-click the type of monitor you want to
create (for example, Job), and then click New Monitor.

After you have given your new monitor a name, the next step is to specify what you want to monitor. If
you are creating a job monitor, you will select which jobs you want to monitor. Be careful to monitor the
smallest number of jobs that will give you the information you need. Monitoring a large number of jobs
may have a performance impact on your system.

You can specify the jobs to monitor in these ways:

Jobs to monitor
You can specify jobs by their job name, job user, job type and subsystem. When specifying job
name, job user and subsystem, you can use an asterisk (*) as a wildcard to represent one or more
characters.

Servers to monitor
You can specify jobs by their server names. Select from the list of Available servers on the
Servers to monitor tab. You can also specify a custom server by clicking the Add custom server
button on the New Monitor or Monitor Properties - General page under the Servers to monitor
tab. To create a custom server, use the Change Job (QWTCHG]B) API

When multiple job selection criteria are specified, all jobs matching any of the criteria are monitored.

For more information about these and other Management Central tasks and topics, refer to the detailed
task help that is available from the iSeries Navigator window. Click Help from the menu bar and select
iSeries Navigator overview » Management Central.

Select the metrics:

For each type of monitor, Management Central offers several measurements, known as metrics, to help
you pinpoint different aspects of system activity. A metric is a measurement of a particular characteristic
of a system resource or the performance of a program or a system.

For a system monitor, you can select from a wide range of available metrics, such as CPU utilization,
interactive response time, transaction rate, disk arm utilization, disk storage, disk IOP utilization, and
more.

For a message monitor, you can specify one or more message IDs, message types, severity levels. You can

also select from a list of predefined sets of messages that are associated with a specific type of problem,
such as a communications link problem, a cabling or hardware problem, or a modem problem.
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For a file monitor, you can select to monitor files across multiple endpoint systems for a specified text
string or for a specified size. Or, you can select to trigger an event whenever a specified file has been
modified. You can select one or more files to be monitored, or you can select the History log option,
which will monitor the i5/0S history log (QHST).

For a job monitor, available metrics include job count, job status, job log messages, CPU utilization, logical
I/0 rate, disk I/O rate, communications I/O rate, transaction rate, and more.

The Metrics page in the New Monitor window allows you to view and change the metrics that you want
to monitor. To access this page, click Monitors, right-click the type of monitor you want to create (for
example, Job), and then click New Monitor. Fill in the required fields, and then click the Metrics tab.

Use the online help to assist you in selecting your metrics. Remember to specify threshold values that
allow you to be notified and to specify actions to be taken when a certain value (called the trigger value)
is reached.

Job monitor metrics

You can use any metric, a group of metrics, or all the metrics from the list to be included in your
monitor. Metrics you can use in a job monitor include the following:

Job Count Monitor for a specific number of jobs matching the job selection.

Job Status Monitor for jobs in any selected status, such as Completed, Disconnected, Ending, Held
while running, or Initial thread held.
Remember: Metrics for job status can affect performance. Limit the number of jobs that
you are monitoring to 40.

Job Log Messages Monitor for messages based on any combination of Message ID, Type, and Minimum
severity.

Job numeric values

CPU Utilization The percentage of available processing unit time used by all jobs that are included by
this monitor on this system.

Logical I/O Rate The number of logical I/O actions, per second, by each job that is being monitored on
this system.

Disk I/O Rate The average number of I/O operations, per second, performed by each job that is being
monitored on this system. The value in this column is the sum of the asynchronous
and synchronous disk 1/O operations.

Communications I/O Rate ~ The number of communications I/O actions, per second, by each job that is being
monitored on this system.

Transaction Rate The number of transactions per second by each job that is being monitored on this
system.

Transaction Time The total transaction time for each job that is being monitored on this system.

Thread Count The number of active threads in each job that is being monitored on this system.

Page Fault Rate The average number of times, per second, that an active program in each job that is

being monitored on this system refers to an address that is not in main storage.
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Summary numeric values

CPU Utilization The percentage of available processing unit time used by all jobs monitored on this
system. For multiple-processor systems, this is the average percent busy for all
processors.

Logical I/O Rate The number of logical I/0O actions, per second, by all jobs monitored on this system.

Disk I/O Rate The average number of I/O operations, per second, performed by all jobs monitored

on this system. The value in this column is the sum of the asynchronous and
synchronous disk I/O operations.

Communications I/O Rate ~ The number of communications I/O actions, per second, by all jobs monitored on this

system.
Transaction Rate The number of transactions per second by all jobs monitored on this system.
Transaction Time The total transaction time for all jobs monitored on this system.
Thread Count The number of active threads for all jobs monitored on this system.
Page Fault Rate The average number of times, per second, that active programs in all jobs monitored

on this system refer to an address that is not in main storage.

Specify the threshold values:

Setting a threshold for a metric that is being collected by a monitor allows you to be notified and,
optionally, to specify actions to be taken when a certain value (called the trigger value) is reached. You can
also specify actions to be taken when a second value (called the reset value) is reached.

For example, when you create a system monitor, you can specify an i5/0S command that stops any new
jobs from starting when CPU utilization reaches 90% and another i5/0OS command that allows new jobs
to start when CPU utilization falls to less than 70%.

For some metrics, it is appropriate to specify a reset value, which resets the threshold and allows it to be
triggered again when the trigger value is reached. For those thresholds, you can specify a command to be
run when the reset value is reached. For other metrics (such as the File Status metric and the Text metric
on file monitors, and any message set on a message monitor), you can specify to automatically reset the
threshold when the trigger command is run.

You can set up to two thresholds for each metric that the monitor is collecting. Thresholds are triggered
and reset based on the value at the time the metric collection is made. Specifying a higher number of
collection intervals in the Duration field helps to avoid unnecessary threshold activity due to frequent
spiking of values.

You can also choose to add an event to the Event Log whenever the trigger value or the reset value is
reached.

On the New Monitor - Metrics page, the threshold tabs provide a place for you to specify a threshold
value for each metric that you have selected to monitor. For example, if you are creating a job monitor,
you can set your threshold values in the following ways depending on the type of metric you have
selected:
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Job Count

Job Log
Message

Job Status

Job Numeric
Values

When you define a threshold, you can specify a command to run on the endpoint system when the
threshold is triggered. For example, selecting » 25 jobs will trigger the threshold whenever the
monitor detects more than 25 jobs running during the number of collection intervals you specify
for Duration.

You can then specify a command to be run on the endpoint system when the monitor detects more
than 25 jobs. Enter the command name and click Prompt for assistance in specifying the
parameters for the command. For more detailed information and examples of specifying commands
to be run when thresholds are triggered, see the performance scenarios topic.

Enable reset is optional, and cannot be selected until a trigger is defined. You can also specify a
command to be run on the endpoint system when the threshold is reset.

You must select Trigger when any of the following messages are sent to the job log before you
can specify the conditions to trigger a threshold. You can specify messages to monitor for based on
any combination of Message ID, Type, and Minimum severity. Each row in the Job Log Message
table shows a combination of criteria that must be met for a message to trigger a threshold. A
threshold will be triggered if it meets the criteria in at least one row. Use the online help to specify
the conditions to trigger a threshold.

Be careful to monitor the smallest number of jobs that will give you the information you need.
Monitoring a large number of jobs for job log messages may have a performance impact on your
system.

You can specify a command to be run on the endpoint system when the threshold is triggered.
Enter the command name and click Prompt for assistance in specifying the parameters for the
command.

Be sure to click the Collection Interval tab to specify how often you want the monitor to check for
job log messages.

A message trigger can only be manually reset. You can specify a command to be run on the
endpoint system when the threshold is reset. When you reset the monitor, you always have the
option to reset without running the specified command.

On the Metrics - General tab, select the statuses that you want to monitor for. Click the Metrics -
Status Threshold tab to specify the conditions to trigger a threshold. You must select Trigger when
job is in any selected status before you can specify the conditions to trigger a threshold. The
threshold is triggered whenever the monitor detects that the job is in any selected status for the
number of collection intervals you specify for Duration.

You can then specify a command to be run on the endpoint system when the threshold is
triggered. Enter the command name and click Prompt for assistance in specifying the parameters
for the command.

Reset when job is not in selected statuses is optional, and cannot be selected until a trigger is
defined. You can specify a command to be run on the endpoint system when the threshold is reset.

When you define the threshold, you can specify a command to run on the endpoint system when
the threshold is triggered. For example, selecting » 101 transactions per second for the Transaction
Rate metric will trigger the threshold whenever the monitor detects more than 101 transactions per
second on any of the selected jobs during the number of collection intervals you specify for
Duration.

You can then specify a command to be run on the endpoint system when the monitor detects more
than 101 transactions per second. Enter the command name and click Prompt for assistance in
specifying the parameters for the command.

Enable reset is optional, and cannot be selected until a trigger is defined. You can also specify a
command to be run on the endpoint system when the threshold is reset.
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Summary When you define a threshold, you can specify a command to run on the endpoint system when the
Numeric Values threshold is triggered. For example, selecting » 1001 transactions per second for the Transaction

(total for all Rate metric will trigger the threshold whenever the monitor detects more than 1001 transactions
jobs) per second on all of the selected jobs during the number of collection intervals you specify for
Duration.

You can then specify a command to be run on the endpoint system when the monitor detects more
than 1001 transactions per second. Enter the command name and click Prompt for assistance in
specifying the parameters for the command.

Enable reset is optional, and cannot be selected until a trigger is defined. You can also specify a
command to be run on the endpoint system when the threshold is reset.

For more information about these and other Management Central tasks and topics, refer to the detailed
task help that is available from the iSeries Navigator window. Click Help from the menu bar and select
iSeries Navigator overview » Management Central.

Specify the collection interval:

When you are setting thresholds for the metrics you have selected to monitor, you should consider how
often you want the data to be collected.

Click the Collection Interval tab to select whether to use the same collection interval for all metrics, or to
use different collection intervals for each metric type. For example, you may want to collect job count
data every 30 seconds, but you may want to collect the job log message data every 5 minutes because job
log message data typically takes longer to collect than job count data.

If you want to monitor numeric and status metrics for less than 5 minutes, you must select Use different
collection interval.

Note: The job count, job numeric values, and summary numeric values metrics must have an equal or
lesser collection interval than the collection interval for the job status metric.

To specify the number of collection intervals for each threshold, click the Metrics tab and indicate the
number of intervals in the Duration field.

Specify threshold run commands:

A threshold is a setting for a metric that is being collected by a monitor. Threshold commands run
automatically on your endpoint system when threshold events occur. Threshold commands are different
from any threshold actions you may have set. Threshold actions happen on your PC or central system,
while threshold commands run on your endpoint systems.

Use of threshold commands

Use threshold settings to automate any i5/0S command you want to run when thresholds are triggered
or reset. For example, suppose you are running a job monitor and a certain batch job that is supposed to
complete before the first shift begins is still running at 6:00 a.m. To accomplish this, you can set up
Threshold 1 to send a page command to a system operator to look at it. You can also set up Threshold 2
to send a command to end the job if it is still running at 7:00 a.m.

In another situation, you might want to notify your operators with a page command when the job
monitor detects that the wait time values for the FTP and HTTP servers have reached a median level. If
the FTP server jobs end, you can restart the server with a start server command (such as STRTCPSVR
*FTP). You can set thresholds and specify commands to automatically handle many different situations. In
short, you can use threshold commands in any way that makes sense for your environment.
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How do | set threshold commands?

On the New Monitor-Metrics page, click the Thresholds tab to enable your thresholds. Before you can set
any threshold commands, you must turn your thresholds on by selecting the Enable trigger (or similarly
named) option. You can then use this window to enter any commands you want to run when the
threshold trigger value is reached. Select the Enable reset (or similarly named) option if you want to
specify a command to run when the threshold reset value is reached.

Management Central monitors allow you to specify any batch commands to run on the server when the
threshold is triggered or reset. You can enter an i5/0S command name and click Prompt (or press F4) for
assistance in specifying the parameters for the command. You can even use replacement variables (such
as &TIME or &NUMCURRENT) to pass information to the command, such as the time and actual value
of the metric.

Specify event logging and actions:

When you have specified the threshold values for your monitor, you can click the Actions tab to select
event logging and the PC actions to be taken when a threshold is triggered or reset.

Some of the actions you can select are:
Log event Adds an entry to the event log on the central system when the threshold is triggered or reset. The

entry includes the date and time the event occurred, the endpoint system being monitored, the
metric being collected, and the monitor that logged the event.

Open event log  Displays the event log when an event occurs.

Open monitor  Displays a list of systems that are being monitored for the specified metrics and a list of the values
for the specified metrics as they are collected for each system.

Sound alarm Sounds an alarm on the PC when the threshold for the monitor is triggered.
Run i5/0S If you have specified a server command to run when the threshold for this monitor is triggered or
command reset, those commands run only during times that actions are applied. This option cannot be

changed from the Actions page. If you do not want the command to run, you can remove the
command from the Metrics page. Whenever you manually reset a threshold, you can select
whether to run the specified reset command.

When you have specified the actions that you want to take when a threshold value is reached, you are
ready to specify when to apply the thresholds and actions you have selected.

How to read the event log

The Event log window displays a list of threshold trigger and reset events for all of your monitors. You
can specify on the Monitor Properties - Actions page for each monitor whether you want events added to
the Event Log. To see the Properties pages for any monitor, select the monitor in the Monitors list and
then select Properties from the File menu.

The list of events is arranged in order by date and time by default, but you can change the order by

clicking on any column heading. For example, to sort the list by the endpoint system where the event
occurred, click System.
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An icon to the left of each event indicates the type of event:

Indicates that this event is a trigger event for which you did not specify a server command to be
x run when the threshold was triggered.

Indicates that this event is a trigger event for which you specified a server command to be run
@ when the threshold was triggered.

Indicates that this event is a threshold reset event.

You can customize the list of events to include only those that meet specific criteria by selecting Options
from the menu bar and then selecting Include.

You can specify which columns of information you want to display in the list and the order in which you
want the columns to be displayed by selecting Options from the menu bar and then selecting Columns.

You can view the properties of an event to get more information about what triggered the event log
entry.

You can have more than one Event Log window open at the same time, and you can work with other
windows while the Event Log windows are open. Event Log windows are updated continuously as
events occur.

Apply thresholds and actions for a monitor:

When you have specified your threshold values and chosen to log events, you can select whether to
always apply these thresholds and actions, or to apply them only on the days and times you choose.

Note: Because system monitors run continuously, the following information does not apply.

If you select to apply thresholds and actions during specified times, you must select the starting time and
the stopping time. If the central system is in a different time zone from the endpoint system, you should
be aware that the thresholds and actions will be applied when the starting time is reached on the
endpoint system that you are monitoring. You must also select at least one day that you want the
thresholds and actions to apply. The thresholds and actions apply from the selected starting time on the
selected day until the next occurrence of the stopping time on the endpoint system.

For example, if you want to apply your thresholds and actions overnight on Monday night, you can
select 11:00 p.m. as the From time and 6:00 a.m. as the To time and check Monday. The actions that you
specified occur whenever the specified thresholds are reached at any time between 11:00 p.m. on Monday
and 6:00 a.m. on Tuesday.

Use the online help to finish creating your monitor. The online help also contains instructions on starting
your monitor.

For more information about these and other Management Central tasks and topics, refer to the detailed
task help that is available from the iSeries Navigator window. Click Help from the menu bar and select
iSeries Navigator overview » Management Central.

View monitor results:

When you have specified when to apply the thresholds and actions you have defined for your monitor,
you are ready to view your monitor results.
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Double-click the monitor name to open the Monitor window. In the Monitor window, you can see the
overall status of the monitor and a list of the target systems that the monitor is running on.

For job, message and file monitors, a list of the target systems (Summary Area) in the upper pane shows
the status of the monitor on each system and the date and time that the monitor data was last collected.
The Summary Area also shows additional information related to the specific metrics being collected.

After you select a system, detailed information about what is being monitored on that system is shown in
the lower pane. For example, if you are viewing a Job Monitor window, the list of jobs in the lower pane
shows the triggered events, the last event that occurred, and the actual values for the specified metrics.

You can select Columns from the Options menu to display additional columns of information. Click Help
on the Columns window to see a description of each column.

From the list in the lower pane, you can right-click any item and select from a menu of actions that can
be performed. For example, if you select a job, you can select reset triggered events, display job
properties, hold, release, or end a job.

For system monitors, detailed information displays as graphs that you can save and print.

You can view all your monitors, as well as all your iSeries Navigator systems management tasks,
remotely with iSeries Navigator for Wireless.

Graph history concepts:
Contains a description of the available options for managing and displaying records of performance data.

Graph history displays data contained in the collection objects created by Collection Services. Therefore,
the type and amount of data available is dependent on your Collection Services configuration.

The amount of data that is available to be graphed is determined by the settings that you selected from
the Collection Services properties, specifically the collection retention period. Use iSeries Navigator to
activate PM iSeries over multiple systems. When you activate PM iSeries, you can use the graph history
function to see data that was collected days ago, weeks ago, or months ago. You go beyond the realtime
monitor capabilities, and have access to summary or detailed data. Without PM iSeries enabled, the graph
data field supports 1 to 7 days. With PM iSeries enabled, you define how long your management
collection objects remain on the system:

* Detailed data (attribute type *PFR in QMPGDATA.LIB or QPFRDATA.LIB)
The length of time that management collection objects remain in the file system before they are deleted.

You can select a specific time period in hours or days, or you can select Permanent. If you select
Permanent, the management collection objects will not be automatically deleted.

* Graph data (attribute type *PFRDTL in QMGTC2.LIB)
The length of time that the details and properties data that is shown in the Graph History window

remains in the system before it is deleted. If you do not start PM iSeries, you can specify one to seven
days. If you do start PM iSeries, you can specify 1 to 30 days. The default is one hour.

* Summary data (attribute type *PFRHST in QMGTC2.LIB)

The length of time that the data collection points of a graph can be displayed in the Graph History
window or remain in the system before they are deleted. No details or properties data is available. You
must start PM iSeries to enable the summary data fields. The default is one month. The summary data
is summarized in one-hour intervals and does not support second- and third-level details.

* Graph history status

The Graph History window now displays the graph history status. You also can re-create the graph
history data if it is missing.
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Use graph history:
This topic contains step-by-step instructions to view graph history through iSeries Navigator.

Graph history is included in iSeries Navigator. To view the graph history of the data that you are
monitoring with Collection Services, do these steps:

1. Follow the iSeries Navigator online help for starting Collection Services on either a single system or
on a system group.

2. From the Start Collection Services - General page, select Start IBM Performance Management for
eServer iSeries if needed.

3. Make changes to the other values for the collection retention period.
4. Click OK.

5. You can view the graph history by right-clicking either a system monitor or a Collection Services
object and selecting Graph History.

6. Click Refresh to see the graphical view.

Tip: If the graph history data is missing, you can re-create it. To re-create the graph history data,
right-click on the object in iSeries Navigator and choose Create Graph History Data.

Once you have launched a graph history, a window displays a series of graphed collection points. These
collection points on the graph line are identified by three different graphics that correspond to the three
levels of data that are available:

* A square collection point represents data that includes both the detailed information and properties
information.

* A triangular collection point represents summarized data that contains detailed information.

* A circular collection point represents data that contains no detailed information or properties
information.

The system adds data from the active collection object (*PFR attribute) to the *PFRDTL and *PFRHST
collection objects when the following occurs:

* If the collection object properties is set to add graph data and summary data when cycled, the
collection is cycled.

* If the already cycled object is selected and the menu option to summarize the data is selected.

 If a system monitor is running, then data is added to the *PFRDTL object only, as the system monitor
is running.

Reset triggered threshold for a monitor:
When you are viewing the job monitor results, you can reset a triggered threshold.

You can choose to run the server command that was specified as the reset command for this threshold, or
you can choose to reset the threshold without running the command.

You can also choose to reset thresholds at the job level, the summary level, the system level, or the
monitor level:

Job level Select one or more jobs in the Job Area of the Job Monitor window. Select File, select Reset with
Command or Reset Only, and then select Jobs. The thresholds for the selected jobs will be reset.
Other thresholds that have been triggered for this monitor remain in the triggered state.
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Summary level  Select one or more systems in the Summary Area of the Job Monitor window. Select File, select
Reset with Command or Reset Only, and then select Summary. The thresholds for job count, job
numeric values metrics, and summary numeric values metrics will be reset. Other thresholds that
have been triggered for this monitor remain in the triggered state.

System level Select one or more systems in the Summary Area of the Job Monitor window. Select File, select
Reset with Command or Reset Only, and then select System. All thresholds for this monitor on
the selected systems will be reset. Thresholds for this monitor that have been triggered on other
systems remain in the triggered state. Any selections you have made in the Job Area are ignored.

Monitor level Select File, select Reset with Command or Reset Only, and then select Monitor. All thresholds for
this monitor on all systems will be reset. Any selections you have made in the Summary Area or
the Job Area are ignored.

Scenarios: iSeries Navigator monitors:

Provides scenarios that show how you can use some of the different types of monitors to look at specific
aspects of your system’s performance.

The monitors included in iSeries Navigator provide a powerful set of tools for researching and managing
system performance. For an overview of the types of monitors provided by iSeries Navigator, see iSeries
Navigator monitors.

For detailed usage examples and sample configurations, see the following scenarios:
Scenario: System monitor:

See an example system monitor that alerts you if the CPU utilization gets too high and temporarily holds
any lower priority jobs until more resources become available.

Situation

As a system administrator, you need to ensure that the iSeries system has enough resources to meet the
current demands of your users and business requirements. For your system, CPU utilization is a
particularly important concern. You would like the system to alert you if the CPU utilization gets too
high and to temporarily hold any lower priority jobs until more resources become available.

To accomplish this, you can set up a system monitor that sends you a message if CPU utilization exceeds
80%. Moreover, it can also hold all the jobs in the QBATCH job queue until CPU utilization drops to 60%,
at which point the jobs are released, and normal operations resume.

Configuration example

To set up a system monitor, you need to define what metrics you want to track and what you want the
monitor to do when the metrics reach specified levels. To define a system monitor that accomplishes this
goal, complete the following steps:

1. In iSeries Navigator, expand Management Central > Monitors, right-click System Monitor, and select
New Monitor...

2. On the General page, enter a name and description for this monitor.
3. Click the Metrics tab, and enter the following values:

a. Select the CPU Utilization Basic (Average), from the list of Available Metrics, and click Add. CPU
Utilization Basic (Average) is now listed under Metrics to monitor, and the bottom portion of the
window displays the settings for this metric.
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b. For Collection interval, specify how often you would like to collect this data. This will override
the Collection Services setting. For this example, specify 30 seconds.

c. To change the scale for the vertical axis of the monitor’s graph for this metric, change the
Maximum graphing value. To change the scale for the horizontal axis of the graph for this metric,
change the value for Display time.

d. Click the Threshold 1 tab for the metrics settings, and enter the following values to send an
inquiry message if the CPU Utilization is greater than or equal to 80%:

1) Select Enable threshold.

N

For the threshold trigger value, specify >= 80 (greater than or equal to 80 percent busy).

w

)
) For Duration, specify 1 interval.
)

N

For the i5/0S command, specify the following:

SNDMSG MSG('Warning,CPU...") TOUSR(*SYSOPR) MSGTYPE(*INQ)

5) For the threshold reset value, specify < 60 (less than 60 percent busy). This will reset the
monitor when CPU utilization falls below 60%.

e. Click the Threshold 2 tab, and enter the following values to hold all the jobs in the QBATCH job
queue when CPU utilization stays above 80% for five collection intervals:

1) Select Enable threshold.

N

For the threshold trigger value, specify >= 80 (greater than or equal to 80 percent busy).

w

)

) For Duration, specify 5 intervals.

) For the i5/0S command, specify the following:
HLDJOBQ JOBQ(QBATCH)

5) For the threshold reset value, specify < 60 (less than 60 percent busy). This will reset the
monitor when CPU utilization falls below 60%.

6) For Duration, specify 5 intervals.
7) For the i5/0S command, specify the following:
RLSJOBQ JOBQ(QBATCH)

This command releases the QBATCH job queue when CPU utilization stays below 60% for 5
collection intervals.

4. Click the Actions tab, and select Log event in both the Trigger and Reset columns. This action creates
an entry in the event log when the thresholds are triggered and reset.

5. Click the Systems and groups tab to specify the systems and groups you want to monitor.
6. Click OK to save the monitor.
7. From the list of system monitors, right-click the new monitor and select Start.

Results

The new monitor displays the CPU utilization, with new data points being added every 30 seconds,

according to the specified collection interval. The monitor automatically carries out the specified

threshold actions, even if your PC is turned off, whenever CPU utilization reaches 80%.

Note: This monitor tracks only CPU utilization. However, you can include any number of the available
metrics in the same monitor, and each metric can have its own threshold values and actions. You
can also have several system monitors that run at the same time.

Scenario: Job monitor for CPU utilization:

See an example job monitor that tracks the CPU utilization of a specified job and alerts the job’s owner if
CPU utilization gets too high.
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Situation

You are currently running a new application on your iSeries server, and you are concerned that some of
the new interactive jobs are consuming an unacceptable amount of resources. You would like the owners
of the offending jobs to be notified if their jobs ever consume too much of the CPU capacity.

You can set up a job monitor to watch for the jobs from the new application and send a message if a job
consumes more than 30% of the CPU capacity.

Configuration example

To set up a job monitor, you need to define which jobs to watch for, what job attributes to watch for, and
what the monitor should do when the specified job attributes are detected. To set up a job monitor that
accomplishes this goal, complete the following steps:

1. In iSeries Navigator, expand Management Central > Monitors, right-click Job monitor, and select
New Monitor...

2. On the General page, enter the following values:
a. Specify a name and description for this monitor.
b. On the Jobs to monitor tab, enter the following values:

1) For the Job name, specify the name of the job you want to watch for (for example,
MKWIDGET).

2) Click Add.
3. Click the Metrics tab, and enter the following information:

a. In the Available metrics list, expand Summary Numeric Values, select CPU Percent Utilization,
and click Add.

b. On the Threshold 1 tab for the metrics settings, enter the following values:
1) Select Enable trigger.

N

For the threshold trigger value, specify >= 30 (greater than or equal to 30 percent busy).

w

)
) For Duration, specify 1 interval.
) For the i5/0S trigger command, specify the following:

SNDMSG MSG('Your job is exceeding 30% CPU capacity')
TOUSR (&0WNER)

5) Click Enable reset.
6) For the threshold reset value, specify < 20 (less than 20 percent busy).

4. Click the Collection Interval tab, and select 15 seconds. This will override the Collection Services
setting.

Click the Actions tab, and select Log event in both the Trigger and Reset columns.
Click the Servers and groups tab, and select the servers and groups you want to monitor for this job.
Click OK to save the new monitor.

© N o O

From the list of job monitors, right-click the new monitor and select Start.

Results

The new monitor checks the QINTER subsystem every 15 seconds, and if the job MKWIDGET is
consuming more than 30 percent of the CPU, the monitor sends a message to the job’s owner. The
monitor resets when the job uses less than 20% CPU capacity.

Scenario: Job monitor with Advanced Job Scheduler notification:

See an example job monitor that sends an e-mail to an operator when the threshold limit of a job is
exceeded.
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Situation

You are currently running an application on your iSeries server, and you want to be notified if the CPU
utilization reaches the specified threshold.

If the Advanced Job Scheduler is installed on the endpoint system, you can use the Send Distribution
using JS (SNDDSTJS) command to notify someone by e-mail when the threshold is exceeded. For
instance, you could specify that the notification escalate to the next person if the intended recipient does
not respond by stopping the message. You could create on-call schedules and send the notification to
only those people that are on-call. You can also send the notification to multiple e-mail addresses.

Job monitor configuration example
This example uses the SNDDST]S command to send a message to a recipient named OPERATOR, which

is a user-defined list of e-mail addresses. You can also specify an e-mail address instead of a recipient or
both. To set up a job monitor that accomplishes this goal, complete the following steps:

Note: By using the code examples, you agree to the terms of the [“Code license and disclaimer]
[information” on page 71)

1. In iSeries Navigator, expand Management Central > Monitors, right-click Job monitor, and select
New Monitor...

2. On the General page, enter the following values:
a. Specify a name and description for this monitor.
b. On the Jobs to monitor tab, enter the following values:

1) For the Job name, specify the name of the job you want to watch for (for example,
MKWIDGET).

2) Click Add.
3. Click the Metrics tab, and enter the following information:

a. In the Available metrics list, expand Summary Numeric Values, select CPU Percent Utilization,
and click Add.

b. On the Threshold 1 tab for the metrics settings, enter the following values:
1) Select Enable trigger.

N

For the threshold trigger value, specify >= 30 (greater than or equal to 30 percent busy).

w

)
) For Duration, specify 1 interval.
) For the i5/0OS trigger command, specify the following:

SNDDSTJS RCP(OPERATOR) SUBJECT('Job monitor trigger') MSG('Job
&JOBNAME s still running!')

5) Click Enable reset.
6) For the threshold reset value, specify < 20 (less than 20 percent busy).

4. Click the Collection Interval tab, and select 15 seconds. This will override the Collection Services
setting.

Click the Actions tab, and select Log event in both the Trigger and Reset columns.
Click the Servers and groups tab, and select the servers and groups you want to monitor for this job.

Click OK to save the new monitor.

© N o o

From the list of job monitors, right-click the new monitor and select Start.

Message monitor configuration example

If you use a message monitor, you can send the message text to the recipient. Here is an example of a CL
program that retrieves the message text and sends an e-mail to all on-call recipients with the SNDDSTJS

command.

Management Central 33



Note: By using the code examples, you agree to the terms of the [“Code license and disclaimer]
finformation” on page 71

PGM PARM(&MSGKEY &TOMSGQ &TOLIB)

DCL &MSGKEY +CHAR 4
DCL &TOMSGQ +CHAR 10
DCL &TOLIB  =CHAR 10

DCL &MSGTXT +CHAR 132

RCVMSG  MSGQ(&TOLIB/&TOMSGQ) MSGKEY (&MSGKEY)
RMV(*NO)  MSG (&MSGTXT)
MONMSG CPFOO0O EXEC(RETURN)

SNDDSTJS RCP(*ONCALL) SUBJECT('Message queue trigger')
MSG (&MSGTXT)
MONMSG MSGID(CPFOO00 I1JSO000)

ENDPGM

This is the command that would call the CL program:
CALL SNDMAIL PARM('&MSGKEY' '&TOMSG' '&TOLIB')

Results

The monitor checks the QINTER subsystem every 15 seconds, and if the job MKWIDGET is consuming
more than 30 percent of the CPU, the monitor sends an e-mail to the operator. The monitor resets when
the job uses less than 20% CPU capacity.

See Work with notification for more information on the Advanced Job Scheduler notification function.
Scenario: Message monitor:

See an example message monitor that displays any inquiry messages for your message queue that occur
on any of your iSeries servers. The monitor opens and displays the message as soon as it is detected.

Situation

You company has several iSeries servers running, and it is time-consuming to check your message queue
for each system. As a system administrator, you need to be aware of inquiry messages as they occur
across your system.

You can set up a message monitor to display any inquiry messages for your message queue that occur on
any of your iSeries systems. The monitor opens and displays the message as soon as it is detected.

Configuration example

To set up a message monitor, you need to define the types of messages you would like to watch for and
what you would like the monitor to do when these messages occur. To set up a message monitor that
accomplishes this goal, complete the following steps:

1. In iSeries Navigator, expand Management Central » Monitors, right-click Message monitor, and
select New Monitor...

2. On the General page, enter a name and description for this monitor.
3. Click the Messages tab, and enter the following values:

a. For Message queue to monitor, specify QSYSOPR.

b. On the Message set 1 tab, select Inquiry for Type, and click Add.

c. Select Trigger at the following message count, and specify 1 message.
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4. Click the Collection Interval tab, and select 15 seconds.
Click the Actions tab, and select Open monitor.

o

6. Click the Systems and groups tab, and select the systems and groups you would like to monitor for
inquiry messages.

7. Click OK to save the new monitor.

8. From the list of message monitors, right-click the new monitor and select Start.

Results

The new message monitor displays any inquiry messages sent to QSYSOPR on any of the iSeries servers
that are monitored.

Note: This monitor responds to only inquiry messages sent to QSYSOPR. However, you can include two
different sets of messages in a single monitor, and you can have several message monitors that run
at the same time. Message monitors can also carry out i5/0OS commands when specified messages
are received.

Work with inventory

Use iSeries Navigator inventory functions to collect and manage various inventories on a regular basis
and to store the data on the iSeries server that you selected as your central system.

For example, you can collect the inventory for users and groups, fixes, system values, hardware
resources, software resources, service attributes, contact information, or network attributes. You may have
other applications installed that allow you to collect lists of other types of resources.

You can either collect an inventory immediately or schedule it to be collected at a later time. You can
schedule the inventory collection to occur daily, weekly, or monthly to keep your inventory current.

For more information about these and other Management Central tasks and topics, refer to the detailed
task help that is available from the iSeries Navigator window. Click Help from the menu bar and select
iSeries Navigator overview » Management Central.

View an inventory
After you have collected the inventory, you can view the inventory list and right-click any item in the list
to see the actions you can perform on the item.

For example, to display the inventory of all installed products on an endpoint system, select Software
Inventory (Management Central » Endpoint Systems » any endpoint system » Configuration and
Service » Software Inventory > Installed Products) This is a very easy way to see what software is
installed on the endpoint system. The Status column reflects the current status of the software (Installed
or Installed and supported) at the time of the last inventory collection (which is shown above the list).

It is recommended that you schedule the collection of all your system inventories on a recurring basis to
keep your central system’s inventory current.

How to use inventories

When you view an inventory on an endpoint system, you can right-click any item in the inventory list to
see the actions you can perform on the item. Also by selecting the properties menu option for an
inventory item (such as hardware) more information is displayed about that item.

For example, here are just a few of the ways that you can use inventories to manage your servers:

 After you have collected fixes inventory, you can compare fixes on one or more endpoint systems to the
fixes on a model system. You can then send the missing fixes to the target endpoint systems and install
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them on those systems. You can also export the fixes inventory to a PC file, which you can use to work
with the data in a spreadsheet program or other application.

* When you are viewing a software inventory, you can select any software product in the list, send it to
one or more target endpoint systems, and install it on those systems. You can also export the software
inventory to a PC file, which you can use to work with the data in a spreadsheet program or other
application.

* Display a hardware inventory list to see the resource, status, and description of all hardware on the
endpoint system. This is a very easy way to check the operational status of your hardware. The Status
column reflects the operational status at the time of the last inventory collection (which is shown above
the list). You can right-click any hardware listed and select Properties. You can review a great deal of
information under the General, Physical location, and Logical address tabs. You can use this
information for upgrades as well as problem analysis. You can also export the hardware inventory to a
PC file, which you can use to work with the data in a spreadsheet program or other application.

* When you display the list for a user inventory, you can right-click one or more users and select any of
the following actions: delete, edit, view the properties, or scan for objects owned by a user. You can do
similar actions with groups by selecting Group Inventory for an endpoint system.

You can search these inventories based on criteria that you specify. Additional search function is
available when you search a users and groups inventory. You can export the results of the search or an
entire inventory to a PC file to work with the data in a spreadsheet program or other application.

Run actions on an inventory

You might have applications installed that define actions that you can run against the collected inventory.
If you have installed an application program that offers an action, you will see that action in the
Available actions list in the Run Actions window.

To see the Run Actions window, right-click any system in the iSeries Navigator window, select Inventory,
and then select Run Actions.

When you select an action from the Available actions list, a list of related inventories is shown under
Inventory for selected action. You should select all the recommended inventories and then click Add to
add this information to the Selected actions to run list.

For example, if you have installed the IBM Electronic Service Agent " option of i5/0S, you can select
Send Electronic Service Agent inventory to IBM from the Available actions list to receive your
inventory data in a series of reports that show your system’s growth and maintenance.

Search a Management Central users and groups inventory
Searching on users and groups provides you with a lot of flexibility to query the user and group
inventory for the information you want.

To access the Search window, right-click an endpoint system and select Inventory > Search .

The Basic search is for quick searches to find a particular user or group. The Advanced search page gives
you the flexibility to search on additional profile properties. For example, you can search for all users on

this endpoint system or system group with security officer authority by selecting Privilege class, and then
selecting Security officer.

You can click And or Or to search on additional fields. For example, if you are searching for all users on

this endpoint system or system group with security officer authority, you can narrow the search to users

in your Accounting department with security officer authority by clicking And and selecting Department
and entering the string Accounting.

From the Search Results window, you can perform many of the actions that you can perform on a user or
group elsewhere within iSeries Navigator. For example, you can delete a user or group, edit the profile
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(for example, remove its Security Officer authority), view its properties, or scan for objects owned by a
user or group. Also from the results window, you can export the search results into a spreadsheet, text
file, or HTML (Web) page.

Advanced search is available only for user and group inventories, which require that both the central
system and the endpoint systems are running OS/400 V5R1 or later.

Run commands with Management Central

iSeries Navigator enables you to define an action or a task and then perform that action or task on
multiple endpoint systems or system groups. These are the same commands that you normally run using
the character-based interface.

For example, you can use a command definition to do any of the following tasks:
* Set network attributes on multiple endpoint systems or system groups
* Set up your own help desk or operations "procedures book” to handle customer and system needs.

Any control language (CL) command that you can run in batch, you can send to multiple systems at the
same time. Create the command definition, and then run the command on endpoint systems or system
groups.

To run a command with Management Central, do the following:
1. Expand Management Central » Endpoint System.

2. Right-click the endpoint system on which you want to run the command and click Run Command.
For more information about this window, click Help.

You can click Prompt for assistance in entering or selecting an i5/0S command. You can choose to run
the command immediately or schedule it to run at a later time.

Starting with V5R3, the command runs under the CCSID of the user profile that is submitting the
command. If the profile is set to 65535 ( or is set to *sysval, and the sysval is 65535), it uses the default
CCsID 37.

Note: Be sure that the command you specify is supported by the release of i5/0S that is running on the
target endpoint system. For example, starting with V5R3 any outputs other than job logs that are
produced by a Run command are viewed by expanding the system under My Connections » Basic
Output ~» Printer Output.

Related information

[About command definitions

Create command definitions

You can create a command definition to save a command that you want to run over and over on multiple
endpoint systems and system groups. Storing a command definition on the central system allows you to
share commonly used or complex commands with other users. When a command is run from a
definition, a task is created.

To create a command definition, do the following:

1. Expand Management Central » Definitions.

2. Right-click Command and select New Definition.
3. The New Command Definition window opens.
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Package and send objects with Management Central

A bulk data transfer is the process of sending packages, fixes, PDFs and so on, from a source system to a
target system in a single transfer. This topic discusses package definitions, what happens when a package
is sent, and how to troubleshoot a failed transfer.

What you can do with package definitions

Sending files to another system or group of systems is a simple point-and-click operation in iSeries
Navigator. If you expect to send the same files again at a later date, you can create a package definition,
which can be saved and reused at any time to send the defined set of files and folders to multiple
endpoint systems or system groups. If you create a snapshot of your files, you can keep more than one
version of copies of the same set of files. Sending a snapshot ensures that no updates are made to the
files during the distribution, so that the last target system receives the same objects as the first target
system.

Another benefit of using iSeries Navigator to package and send objects is that you can run a command
when the distribution of the package is complete. This means that you can:

* Distribute a batch input stream and run it.
* Distribute a set of programs and start your application.
¢ Distribute a set of data files and run a program that acts on that data.

You can specify whether to include subfolders in the package. You can also specify whether to keep or
replace any file that already exists on the target system. You can start the send task immediately or click
Schedule to specify when you want the task to start.

You can select and send files and folders without creating a package definition. However, a package
definition allows you to group together a set of i5/0OS objects or integrated file system files. The package
definition also allows you to view this same group of files as a logical set, or as a physical set, by taking
a snapshot of the files to preserve them for later distribution.

For more information about these and other Management Central tasks and topics, refer to the detailed
task help that is available from the iSeries Navigator window. Click Help from the menu bar and select
iSeries Navigator overview » Management Central.

Troubleshooting a failed transfer

* Look at the task’s job log and try to determine a cause. From the Task Status window, right-click the
failed endpoint and click Task Output.

Sending packages uses the Save/Restore function. When a save or restore operation issues an error or
warning message, the Management Central package send function marks the status as failed. This does
not necessarily mean that the entire process failed. You need to check the job log and determine the
cause of the failure. It is possible that there is a message that indicates that the restore function worked
with limitation and thus generated a warning.

* Make sure that the target system can connect back to the source system.

On the endpoint system ping itself by the long name. If this is successful, then on the source system,
ping the endpoint system using its long name.

To complete a successful transfer, the target system must connect back to the source system. The IP
address that is used on the target system is determined by the lookup frequency on the target system.
If the lookup frequency is Never then the IP address that is used is the one that is provided by the
central system for the source system.

It might be that target system cannot connect to the source system via this IP address, but can connect
by using a different IP address, one that is defined in its host table. If the lookup frequency on the
target is set to Always then it will use DNS, the host table, or both to determine the IP address of the
source system and it will not use the IP address that is provided by the central system.
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Distribute fixes to multiple servers with iSeries Navigator

If you have a network of iSeries servers that you want to keep at the same fix level, find out how simple
your servers are to manage when you use the Compare and Update wizard. Find out how to install your
fixes on remote systems with iSeries Navigator.

After you have received your fixes, you can use iSeries Navigator to distribute your fixes to other servers
in your network. In the past, object distribution and Systems Network Architecture distribution services
(SNADS) were the choices when you wanted to send objects. If you are in a TCP/IP environment, you
can now use the iSeries Navigator graphical interface function of Management Central to send and
distribute your fixes.

To understand how a network is set up, see the following list for a description of the different roles. A
single system can assume more than one role. For example, the same system can be the central system,
the source system, and a model system.

Central system
Central system directs and tracks activity in your environment. It has an active iSeries Access
connection from your graphical client, and it is currently selected as the central system. Its server
and inventory provide your view of the Management Central tasks and endpoints.

Endpoint systems
Endpoint systems are the systems that you are managing in your environment. The endpoint
systems are controlled by the central system. The endpoint systems were discovered or created on
your central system.

Source system
This is the system from which items are sent when performing a task. The source system is the
source of the item that is sent. This is the system that you have selected to be the repository for
the save files for the fixes that you will distribute to your other servers.

Target system
This is the system to which items are sent when performing a task. The target system is the
destination of the item that is sent.

Model system
This is the system that is set up exactly the way you want it with regard to installed fixes. It has
the fixes installed that you decided should be installed. You want the other systems that you are
managing to have the same fixes installed as the model system. When you use the Compare and
Update wizard, you make managing your fixes a lot easier.
Related information
[Send and install fixes|

[Compare and update fixes|

Manage users and groups with Management Central

iSeries Navigator can help you as a system administrator to keep track of the users, groups, and their
level of privileges on one or more endpoint systems.

For more information about these and other Management Central tasks and topics, refer to the detailed
task help that is available from the iSeries Navigator window. Click Help from the menu bar and select

iSeries Navigator overview » Management Central.

The following list gives you an idea of the many ways in which iSeries Navigator can make your job
easier.
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Create a user
definition

Create, edit, and delete
users and groups

Collect an inventory

You can create a user definition and then create multiple users across multiple systems
based on the definition. First, create user definitions for the types of users on your systems.
Then, when a request comes in for a new user, all special authorities, attributes, and other
information common to that type of user are already stored in the user definition. You can
even specify a command to be run after a user is created from a user definition! If you need
assistance in entering or selecting an i5/0S command, you can click Prompt to select
appropriate parameters and values.

When you create a new user from the user definition, you specify the name for the user, a
brief description to help you identify this user in a list of users, and a new password for the
user. All other properties of the new user are based on the properties stored in the user
definition, unless you choose to change them. You may also select the groups the user
should belong to and provide personal information about the user at the time the user is
created.

You can create, edit, and delete users and groups across multiple endpoint systems or
system groups--and even schedule these actions. For example, use the Edit Users function to
change the properties for one or more users on the selected endpoint systems or system
groups. If you need to change the authority level for several users on multiple systems, or if
a user who has access to multiple systems changes his or her name, you can easily edit that
information and apply the change to all systems.

When you use iSeries Navigator to delete users, you can select an action to be taken if any
of the selected users owns objects on any system from which that user is being deleted. You
can click Scan for Owned Objects to see what objects the selected users own on the selected
endpoint systems or across the selected system groups.

You can collect an inventory of the users and groups on one or more endpoint systems, and
then view, search, or export that inventory to a PC file. Extensive advanced search
capabilities are provided for easy searching. For example, you can search the inventory to
see who has Security Officer privileges, as well as query other profile properties. Also, you
can sort these inventory lists by clicking on any column heading. For example, you can
group together all users in the inventory who have Security Officer privileges by clicking the
Privilege Class heading.

You can perform various actions from the User Inventory list by right-clicking one or more
users and selecting an action from the menu. For example, you can delete a user, edit a user,
view its properties, or scan for objects owned by a user. You can do similar actions with
groups by selecting Group Inventory for an endpoint system.

It is recommended that you schedule collection of users and groups inventory on a recurring
basis to keep your central system’s inventory current. Changes that you make to the user or
group inventory on an endpoint system or system group under Management Central are
automatically updated in the current central system’s inventory.
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Send users and groups

Scan for owned objects

Synchronize unique
identifiers

You can send users and groups from one system to multiple endpoint systems or system
groups. All the user properties you need are sent to the target systems, including the user
name and passwords (LAN server password as well as the i5/0S password), security
settings, private authorities, Enterprise Identity Mapping (EIM) associations, and mail
options. If the user has an entry in the system distribution directory on the source system,
an entry is created (or updated) for that user on the target system.

You can also specify the action to be taken if any user in the list that you are sending
already exists on the target system. When you are sending users, you can select not to
change the user that already exists, or you can select to update the existing user with the
settings from the user you are sending. When you are sending users, you can click
Advanced to specify advanced send options. The advanced send options include specifying
the mail system for the user and synchronizing the unique identifier of the user on the
target system based on the user identifier of the user being sent.

To send users or groups from one system to another, you must also have save/restore
(*SAVSYS) authority.

You can scan for owned objects to find out what objects a user or group owns across
multiple endpoint systems or system groups, and you can even scan for objects owned by
multiple users simultaneously.

You can synchronize the unique identifiers of users and groups across multiple endpoint
systems to ensure that each of these numbers points to the same user on every system. This
is especially important when you are working with systems in a clustering environment or a
system with logical partitions. The user identification and group identification numbers are
another way of identifying a user or group to a program. For example, the user
identification and group identification numbers are used by programming interfaces in the
integrated file systems environment.

You can choose to synchronize unique identifiers when you create new users or groups,
when you edit users or groups, or when you send users or groups from one system to
another. Be sure to keep your user and group inventories current if you are synchronizing
unique identifiers when you create or edit users or groups.

Note: All i5/0S special authorities and other authorities that are needed when working with users and
groups in the character-based interface are honored when managing users and groups with iSeries
Navigator. This includes security administration (*SECADM) privileges, all object (*ALLOB]J)
privileges, and authority to the profiles with which you are working. However, even a user with
the most restricted set of system privileges (*USER) can view, search, or export a user or group
inventory that has been collected by another user with the correct authorities. The user with *USER
authority cannot create or delete users, edit existing users, or send users to another system.

Related concepts

[“Synchronize functions” on page 43|

You can synchronize the configuration of key functions, such as EIM and Kerberos, across a group of

endpoint systems.

Related information

Scenario: Configure the Management Central servers for single signon|

Propagate system settings from the model system (iSeries A) to iSeries B and iSeries C]

Share with other users in Management Central

Sharing saves you time, makes system administration easier, and reduces the number of redundant tasks
you need to do. As of V5R4, you can now share system monitors and system events.

Sharing allows you to use (or share) the same items: monitors, monitor events, system groups,
definitions, and system administration tasks. You can even set your user preferences to share all of the
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w tasks that you create. For example you might give a user special authority (administered under Host

Applications in Application Administration) to view all tasks, definitions, job monitors, message
monitors, file monitors, activity monitors, system monitors, system events, and system groups under
Management Central in the iSeries Navigator window.

Only the owner of an item can change the level of sharing. The owner can specify any of the following
levels of sharing:

None Other users cannot view this item. Only the owner of the item or a user with special authority

Re

administered under Host Applications in Application Administration can view this item. Users
with this special authority, called Management Central Administration Access, can view all tasks,
definitions, job monitors, message monitors, system monitors, system events, and system groups
under Management Central in the iSeries Navigator window.

ad-Only Other users can view this item and use it. Other users can create a new item based on this one and
make changes to the new one as needed. However, other users cannot delete or change this item in
any way. If you are the owner of a monitor and have specified actions (such as opening the event
log window or sounding an alarm on the PC), these actions occur for all users of the monitor
whenever a threshold is triggered or reset. The other users cannot change these actions. If the item
(a task or a monitor) is running, other users cannot stop it.

Controlled Other users can start and stop this task or monitor. Only the owner can delete the item or change

Fu

any properties of this item, including the level of sharing. Other users can also view this item and
use it to create a new item based on this one. If you are the owner of a monitor and have specified
actions (such as opening the event log window or sounding an alarm on the PC), these actions
occur for all users of the monitor whenever a threshold is triggered or reset. The other users cannot
change these actions. Any actions that are associated with running a monitor that was created by
another user (the owner) runs under the authority of the owner. Therefore, as the owner, you
might be sharing a monitor with someone who does not have the same level of authority as you.

11 Other users can change and delete this definition or system group. Other users can also view this
item and use it to create a new definition or system group.

Uses for sharing objects and tasks

What you can do with sharing depends on the needs of your work environment. Consider these
examples:
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You can share job monitors, message monitors, system monitors, and file monitors.

When you share monitors, others can use the monitors that you set up to measure the monitored
activity on the systems in your network. If you choose Read-Only sharing, others can open the
monitor and its event log, and they can view the properties of the monitor. If you choose Controlled
sharing, others can also start or stop the monitor. The level of sharing that you specify when you create
a monitor also applies to any events that are logged when a threshold is triggered or reset. You can
change the level of sharing for events after they have been logged.

You can share system groups.

When you share system groups, other users can view the system groups and use them to perform
authorized actions. Unless you specify Full sharing, you control the endpoint systems in the system
group for all authorized users. This ensures that the system group is always up to date. Suppose you
created a system group called "West Coast Systems.” If you chose to share that group, all system
operators can use that system group to work with the West Coast systems. If you specify Full sharing,
other users may update the contents of that group.

You can share definitions.

Part of your job might include maintaining a "run book” of commonly used commands. You can share
the command definitions in that run book to ensure that the commands your system operators run are
accurate. If you need to make a change to one of those commands, you only need to do it once. Your
users can share that one set of accurate commands.

You can also share package definitions, product definitions, and user definitions. By sharing
definitions, you save other users the time it takes to create their own definitions.
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* You can share tasks.

Tasks are long-running actions in iSeries Navigator. You can share any actions that have been created
and allow users to see the status of tasks. For example, suppose you needed to install 50 fixes on a
system group containing 50 systems. If you shared that task, you can start the task and then go home
while letting the second shift operators see the status on their PC.

* You can use global sharing to share all tasks.

Use global sharing to specify the level of sharing for all your system administration tasks -- None,
Read-Only, or Controlled sharing. You access global sharing through the User Preferences window by
right-clicking on Management Central. When you specify a value other than None, the sharing value
applies to all future tasks that are created with iSeries Navigator on this PC. Existing tasks are not
affected. For example, suppose you are in an environment where you are part of a five-person team
that works around the clock. If you chose to globally share your tasks at the Controlled level, your
team can see what you did and work with the tasks you started -- even when you are not there.

Synchronize date and time values

Management Central gives you a convenient way to synchronize date and time values across your
network.

To synchronize the date and time values across your network, select your endpoint systems or system
groups whose date and time values you want to update from the Endpoint Systems list under
Management Central in iSeries Navigator. Then, right-click any selected system and select System Values
» Synchronize Date and Time. Specify a model system that has the most accurate date and time values.

The date and time system values that are updated on the target systems include system date
(QDAYOFWEEK, QDATE, QDAY, QMONTH, QYEAR), time of day (QTIME, QHOUR, QMINUTE,
QSECOND), and time zone (QTIMZON). To verify that a time adjustment is being made, select the
endpoint system from the list under My Connections (or your active environment) in iSeries Navigator.
Then, go to Configuration and Service » Time Management »> Time Adjustment to view the current
time adjustment.

The time used from the model system is the software clock time rather than the QTIME system value.
The software clock time is the same as the QTIME system value except when the SNTP (Simple Network
Time Protocol) client is started on the model system. When SNTP is running on the model system, the
software clock is synchronized to the time server specified in the SNTP configuration. For more
information about configuring SNTP, see Simple Network Time Protocol (SNTP).

You can choose to synchronize the time without changing the time zone, or synchronize both the time
and the time zone with those on the model system.

When a system changes to or from Daylight Saving Time (DST), the GMT offset (QUTCOFFSET) system
value is automatically updated from the GMT offset attribute of the time zone (QTIMZON) system value.

Related information
[Simple Network Time Protocol (SNTP)

Synchronize functions

You can synchronize the configuration of key functions, such as EIM and Kerberos, across a group of
endpoint systems.

You select a model endpoint system and a set of target endpoint systems, and then use the Synchronize
Functions wizard to duplicate the model system’s Kerberos or EIM configurations (or both) on the
specified target systems. Synchronizing these functions from the model system saves you time by
eliminating the task of individually configuring each function on each target system. Synchronizing your
EIM configurations allows you to create EIM associations between user identities within your network.
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This in turn allows a user who has different profiles on different systems to work with distributed
applications that use Kerberos authentication without having to sign on to each of these systems
individually.

For example, John Smith may be JSMITH on system CHICAGO1, JOHNSMITH on system DETROIT1,
and JRSMITH on system DENVER. If EIM and Kerberos are configured on all three systems, and all three
profiles are associated with the same EIM identifier, John Smith can use Management Central to manage
these V5R3 systems. For example, he can run commands on these systems, and monitor performance,
jobs, and other resources on these systems. John Smith can also access other services and applications that
use EIM and Kerberos authentication without the need for multiple passwords to these different systems
across the enterprise.

Using Kerberos and EIM together in this way is referred to as single signon because it eliminates the need
to provide multiple user names and passwords for distributed applications. Single signon benefits users,
administrators, and application developers by enabling an easier password management system across
multiple platforms without the need to change underlying security policies. See Single signon for details
on how to enable single signon by using network authentication service and Enterprise Identity Mapping
(EIM).

Note: If the SNTP box is checked then a TCP job QTOTNTP should be running on the endpoint. If it is
not running then Management Central will use information from the model system. If SNTP is
checked and the client QTOTNTP job is running then you should not run multiple Time
Synchronization tasks within one polling interval of the SNTP client. You can view the SNTP
polling interval at My Connections > server » TCP/IP » Right-click SNTP » Properties » Client
tab .

Related concepts

[‘Manage users and groups with Management Central” on page 39|
iSeries Navigator can help you as a system administrator to keep track of the users, groups, and their
level of privileges on one or more endpoint systems.

Related information

[Scenario: Configure the Management Central servers for single signon|

[Propagate system settings from the model system (iSeries A) to iSeries B and iSeries C|

Schedule tasks or jobs with Management Central scheduler

iSeries Navigator provides two different tools you can use to schedule tasks or jobs: an integrated
scheduler (the Management Central scheduler) and the Advanced Job Scheduler.

Management Central scheduler

The Management Central scheduler helps you to organize when you want your tasks to occur. You have
the option of choosing to perform a task immediately or choosing a later time.

You can use the Management Central scheduler to schedule a variety of tasks. For example, you can
automate the process of collecting an inventory (such as hardware, software, or fixes) on whichever day
fits your operating schedule. You might schedule such a collection to occur every Saturday night at 10
p-m. You can also schedule to clean up the save files and cover letters of the fixes from your systems on
the first of every month. Or you might want to install a set of fixes once.

Using the scheduler function gives you the flexibility to do your work when it is convenient for you. In
addition, you can use the Management Central scheduler to do almost any task in Management Central.
For example, you can schedule when to do any of the following tasks:

* Run commands on selected endpoint systems and system groups

* Collect inventory on selected endpoint systems and system groups
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* Collect system values inventory on selected endpoint systems and system groups; then compare and
update system values to those on a model system

* Create, delete, edit, and send users and groups across multiple endpoint systems

* Send fixes or packages of files and folders to selected endpoint systems and system groups

* Start installing fixes, uninstall fixes, or install fixes permanently

* Delete the save files and cover letters for selected fixes on selected endpoint systems and system
groups

e Start and stop Collection Services on selected endpoint systems and system groups

You can schedule a task to run once, in which case the task runs a single time beginning at the specified
date and time.

To schedule a later time to perform a task, click Schedule from any window in which the button is
displayed. Your scheduling information is stored on the central system and submitted from there. No
scheduling function is needed at the endpoint system.

The following scheduling options are available from the Management Central scheduler:
* Daily

The task runs every day at the specified time beginning on the specified date.
* Weekly

The task runs every week at the specified time beginning on the specified date. You may either accept
the default (today’s date) or specify the day of the week when you want the task to run.

* Monthly

The task runs every month at the specified time beginning on the specified date. You may either accept
the default (today’s date) or specify a day of the month (1-31), First day, or Last day.

You can schedule any task for which a Schedule button is available. For example, you can schedule a
specific time to collect inventory. (If you want full calendar management, you should use the Advanced
Job Scheduler.)

Important: Do not use the Work with Job Schedule Entries (WRKJOBSCDE) to alter or delete a scheduled
job if that job was scheduled using the Management Central Scheduler or the Advanced Job
Scheduler. If the job is altered or deleted by using WRKJOBSCDE, Management Central is not
notified of the changes. The task might not run as expected, and error messages can appear
in the Management Central server job logs.

For more information about these and other Management Central tasks and topics, refer to the detailed
task help that is available from the iSeries Navigator window. Click Help from the menu bar and select
iSeries Navigator overview » Management Central.

Advanced Job Scheduler

The Advanced Job Scheduler is a separate licensed program (5722-JS1) that you can install and use to
schedule tasks and jobs. This scheduling tool provides more calendar features and offers greater control
over scheduled events. If you have Advanced Job Scheduler installed, click the Schedule button from any
iSeries Navigator window to schedule tasks and jobs. To find more information about installing and
using this tool, see the Advanced Job Scheduler topic.

Advanced Job Scheduler

The Advanced Job Scheduler licensed program (5722-]JS1) is a robust scheduler that allows unattended job
processing 24 hours a day, 7 days a week. This scheduling tool provides more calendar features and
offers greater control over scheduled events than the Management Central scheduler. You can also view
job completion history and manage notification of a job’s status.
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It is not necessary to install the Advanced Job Scheduler licensed program on each endpoint system in
your Management Central network. When you install the Advanced Job Scheduler on the central system,
jobs or tasks that you define on an endpoint system will gather job information that is needed from the
central system. However, you must set up all job definition information on the central system.

If systems in your network have the Advanced Job Scheduler installed locally, you can schedule tasks
outside of the Management Central network. Under My Connections in iSeries Navigator, you have
access to the Advanced Job Scheduler on that local system when you expand Work Management.

Advanced Job Scheduler for Wireless
Advanced Job Scheduler for Wireless is a software application that allows you to access Advanced Job

Scheduler on multiple Internet-accessible devices, such as an Internet-ready telephone, PDA Web browser
or PC Web browser.

The wireless feature of Advanced Job Scheduler resides on your iSeries system, where Advanced Job
Scheduler is installed, and allows you to access your jobs and activity, as well as send messages to
recipients on your system, and stop and start the Advanced Job Scheduler monitor. Advanced Job
Scheduler for Wireless allows each user to customize the settings and preferences of their browsing
experience. For instance, a user can show activity, display jobs, and customize the jobs they display.

Advanced Job Scheduler for Wireless allows you to access your jobs when you are normally unable to
access an iSeries terminal or emulator. Connect to the Internet with your mobile device and enter the
URL for the Advanced Job Scheduler for Wireless servlet. This launches a menu that gives you real-time
access to Advanced Job Scheduler.

Advanced Job Scheduler for Wireless works on two types of devices. A Wireless Markup Language
(WML) device is an Internet-ready cellular phone. A Hypertext Markup Language (HTML) is a PDA or
PC Web browser. Throughout this topic, the different devices are referred to as WML and HTML.

Schedule jobs with Advanced Job Scheduler

The following information will help you manage the Advanced Job Scheduler. You first need to install the
licensed program, and then read about the tasks that allow you to customize the Advanced Job
Scheduler. Finally, the remainder of the tasks allow you to work with and manage this scheduler.

What's new in Advanced Job Scheduler for V5R4:
Several enhancements have been made to the Advanced Job Scheduler.

Add multiple commands to a scheduled task

e A command list is a stored set of instructions that Advanced Job Scheduler uses to process
Management Central jobs. You can now add a series of commands to the scheduled Management
Central task and control the run sequence of these commands. In the past you could only schedule one
Management Central task (you could schedule one job to collect inventory, then another job to install
fixes, and another one to run commands). Now you can create one Advanced Job Scheduler job that
does all those activities.

When scheduling a task, you have the option to create a new scheduled job, create a new scheduled
job based on an existing scheduled job, or add the task to an existing job. CL commands can also be
added to Management Central scheduled tasks. For instance, to delay the job between tasks you can
use the Delay Job (DLYJOB) command.

Tasks are processed on the endpoint system that was selected when the task was created. However, all
CL commands are processed on the Central system. Each task must complete before the next task or
CL command in the list will process.

After you click the Schedule button for a Management Central task, the next window prompts you to
specify whether you want to create a new job, create a new job based on another job, or add to an
existing job.
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The Command field is located on the Scheduled Job Properties - General window. (My
Connections > server » Work Management » Advanced Job Scheduler » Scheduled Jobs -
Right-click a job » Properties)

Notification Banner control

* When you distribute spooled files by using Report Distribution, you can now choose from a list of
items and have them print in a large font on the banner page of the new spooled file. The default
items are Job name and Spooled file name. You can select up to 2 banner items to print large.

The Available banner items field is located on the Notification Properties window. (My
Connections » server » Work Management > Advanced Job Scheduler » Right-click Notification
» Properties)

Add send e-mail menu option on system

* This new menu option allows you to use the Advanced Job Scheduler to send an e-mail. When you
select this menu item, the New E-Mail Message window appears. This is the same window that
appears when you click My Connections » server > Work Management » Advanced Job Scheduler -
Notifications » Right-click E-mail » New E-mail.

My Connections » Right-click a server » Send e-mail via AJS

Distribute reports via the Basic Operations container

¢ The Distribute Reports window provides you with a place to manually distribute spooled files that are
generated by a user job that is using a report distribution list. The job can be a job started by
Advanced Job Scheduler or manually by a user. You will be prompted for a Report Distribution List.
The Report Distribution List is a list of spooled files and the recipients to whom the spooled files will
be delivered.

My Connections ~ server » Basic Operations » Jobs » Right-click a job » Distribute Reports

Availability schedule for e-mail recipients

* The availability schedule is the schedule for which the recipient is available to receive notification
messages. You can select Always available, blank (never available) or a schedule option that was
previously defined in the Advanced Job Scheduler - Schedules properties window.

The Availability schedule field is located on the Recipient Properties - Email window. (My
Connections > server » Work Management > Advanced Job Scheduler » Notifications -

Recipients » Right-click a recipient name > Properties)

Work Flow Manager

* The [Work Flow Manager|is a new tool that lets you define units of work that can consist of a
combination of automated and manual steps. The units of work can then be scheduled or started
manually. With various notification check points, users can be notified when steps have started,
completed, did not run by a specific time, and exceeded the run limit. Each step may have predecessor
and successor jobs. Predecessor jobs for a step must complete before the step can be automatically or
manually completed. After a step has completed, successor jobs are set to run. It is common to specify
predecessor jobs that are the same as the successor jobs of the previous step. This causes the step to
wait until the jobs complete before notifying of the step’s completion.

A good candidate for using the Advanced Job Scheduler Work Flow Manager is payroll processing. The
payroll process consists of manual steps such as inputting time cards, validating reports, and printing
and disbursing checks. The automatic steps can clear the batch work files, process time card input, run
the payroll updates, and create the reports and checks.
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My Connections » server > Work Management » Advanced Job Scheduler » Work Flow
Manager

Integrated file system Object Resource Dependency

* The Resource Dependencies window displays information about a specific job’s resource
dependencies, including a list of dependencies, the requirements needed before continuing to run a job,
and the time to wait before resetting a job, as well as allows you to add, remove, or view the
properties of a particular resource dependency. New to V5R4 you can indicate if this dependency
object is an integrated file system and specify the path.

My Connections > server > Work Management » Advanced Job Scheduler » Scheduled Jobs -
Right Click a job » Resource Dependencies » Create a new dependency type object

Page Selection for notification spool file attachments
* Page Selection allows you to specify selection information based on text and its location within each

page of a spooled file. You can specify that the text must exist at a specific location on each page or
anywhere on the page. You can also subset the spooled file by selecting a page range.

The Page Selection function can be found at My Connections ~ server > Work Management -
Advanced Job Scheduler » Notification » Report Distribution List » Right-click a list »
Properties » Click a spooled file » Click Properties

Add option to not reset held jobs

¢ Currently there is a possible performance impact when jobs that are scheduled to run periodically are
held. Each time the scheduled date and time is reached for a held job, the Advanced Job Scheduler
server job determines if the job is still held, and if so, calculates the next date and time the held job
should run. New for V5R4, you can suppress this calculation by making sure that the Reset held jobs
field is unchecked. When the Reset held jobs field is unchecked, the next time the date and time is
reached for a held job, the scheduled date and time fields are cleared, and no further processing
activity is triggered on the held job. When you release the job, the server then calculates the next date
and time the job should run. Using the Reset held jobs field applies to all jobs defined using the
Advanced Job Scheduler.

The Reset held jobs field is located on the Advanced Job Scheduler Properties - General
window. (My Connections > server > Work Management » Right-click Advanced Job Scheduler
» Properties)

Install the Advanced Job Scheduler:

The first time that you connected to your Management Central server, iSeries Navigator asked you if you
wanted to install the Advanced Job Scheduler. If you chose no and want to install it now, you can do so
by using the Install Plug-Ins feature of iSeries Navigator.

1. From your iSeries Navigator window;, click File from the menu bar.
2. Click Install Options ~ Install Plug-Ins.

3. Click the source system where the Advanced Job Scheduler is installed and click OK. Check with the
system administrator if you are not sure what source system to use.

Enter your iSeries User ID and Password, and click OK.
Click Advanced Job Scheduler from the Plug-in selection list.
Click Next and then click Next again.

Click Finish to complete and exit the setup.
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You have now installed the Advanced Job Scheduler.

Locate the scheduler:
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To locate the scheduler, follow these steps:
1. Expand Management Central.

2. Click Scan Now in response to the message that iSeries Navigator has detected a new component.
You might see this message again when you access systems from the My Connections container.

3. Expand My Connections - of the the iSeries server that has the Advanced Job Scheduler licensed
program installed » Work Management > Advanced Job Scheduler.

After you have finished this preliminary work with the Advanced Job Scheduler, you are ready to set up
the Advanced Job Scheduler.

Set up the Advanced Job Scheduler:

After you have installed the Advanced Job Scheduler, you need to configure it. After you have finished
this preliminary work, you are ready to begin scheduling jobs.

Assign the general properties:

Assign the general properties used by Advanced Job Scheduler. You can specify how long to retain
activity and log entries for the Advanced Job Scheduler, as well as the period that jobs will not be
allowed to run.

You can specify the working days that jobs will process, and whether an application is required for each
scheduled job. If you have a notification product installed, you can also set up the command that will be
used to send a notification when a job completes or fails or you can use the Send Distribution using Job
Scheduler (SNDDST]JS) command to notify a recipient

You can specify how long to retain activity records for jobs, as well as the period that jobs will not be
allowed to run. You can specify the working days that jobs are allowed to process, and whether an
application is required for each submitted job.

You can have a notification product installed which allows you to receive a notification (message) when a
job ends. You can define the notification command that will send a notification when a job completes or
fails or you can use the Send Distribution using Job Scheduler (SNDDSTJS) command to notify a
recipient.

To set up the general properties for the Advanced Job Scheduler, follow these steps:
1. Expand Work Management from your iSeries Navigator window.
2. Right-click Advanced Job Scheduler and click Properties.
3. Specify the Activity Retention. The activity retention is how long you want to retain the activity
records for jobs. The possible values are 1 to 999 days or occurrences. Click Days to specify if you

want to keep activity for a certain number of days, or click Occurrences per job if you want to keep
activity for a certain number of occurrences per job.

4. Specify the Log retention. The log retention specifies, in days, how long you want to retain
Advanced Job Scheduler log entries.

5. You can specify a Reserved period. Jobs will not run during this time.

6. Specify the working days from the list. If a day is selected, it is designated as a working day and can
be referenced when scheduling jobs.

7. Click Application required for scheduled job to designate whether an application is required for
each scheduled job. Applications are jobs that have been grouped together for processing. This
cannot be selected if existing jobs do not contain an application. If you choose to have an application
required for certain jobs, go to working with applications.

8. Click Calendars to set up the scheduling, holiday, and fiscal calendars to use, set up holiday
calendar, and set up fiscal calendar.
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9. Click Base periodic frequency on start time to base the next run time on the start time for jobs that
are scheduled to run periodically. For instance, a job is to run every 30 minutes, starting at 8:00 am.
(For a job to run around the clock, specify 7:59 am as the ending time.) The job runs for a total of 20
minutes. With this field checked, the job runs at 8:00 am, 8:30 am, 9:00 am, and so on. If this field is
not checked, the job runs at 8:00 am, 8:50 am, 9:40 am, 10:30 am, and so on.

10. Click Reset held jobs to continue to recalculate and display the next date and time a held job runs.

11. Specify a Start time of day. This is the time of day that you consider starts a new day. All jobs that
are specified to use this time of day will have their job date changed to the previous day if the time
the job starts is before the Start time of day field.

12. Specify a Job monitor user. This field specifies the name of the user profile to use as the owner of
the monitor job. All jobs that have Current user specified use the user profile of the monitor job. The
monitor job’s default user profile is QIJS.

13. In the Notification command field, you can specify a command. Use the Send Distribution using Job
Scheduler Notification (SNDDST]S) command supplied with the system or a command specified by
your notification software. The SNDDSTJS command uses the Advanced Job Scheduler notification
function. The designated recipients can receive messages for normal and abnormal completions of
job scheduled entries.

Specify permission levels:
Specify permission levels for jobs, functions of the product, and provide new job default permissions.

You can specify permission levels for jobs, functions of the product, and provide new job default
permissions to be associated with each Job Control/Application. The permissions for a job allow you to
grant or deny access to the following actions: submit, manage, permission, display, copy, update, or
delete. You can also grant or deny access to individual functions of the product such as Work with
Schedule Calendars, Send Reports, and Add Job.

Default permission levels are transferred to new jobs when they are added. In which case, the system will
transfer the New Job permissions based on the application specified within the job definition. If no
application is used, it will transfer the *SYSTEM New Job permissions.

Specify permission levels for functions of the product:

To specify permission levels for functions of the product, follow these steps:
1. Expand Work Management from your iSeries Navigator window.
2. Right-click Advanced Job Scheduler and selectclick Properties.

3. Click Permissions.
4. Select a function and click Properties.
5. On the Function Permissions Properties window, edit the permission level as necessary. You can grant

or deny access to the public or specific users.
Specify permission levels to jobs:

To specify permission levels to jobs, follow these steps:

1. Expand Work Management from your iSeries Navigator window.

2. Right-click Advanced Job Scheduler and click Scheduled Jobs to list jobs.
3. Right-click the scheduled job and click Permissions.
4

. On the Permissions Properties window, edit the permission level as necessary. You can grant or deny
access to the public or specific users. In addition, you can specify submit, manage, permission,
display, copy, update, or delete permissions.

Specify default permission levels:
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To specify default permission levels for new jobs associated with a Job Control/Application, follow these
steps:

1. Expand Work Management from your iSeries Navigator window.

Right-click Advanced Job Scheduler and click Properties.

Click Job Controls/Applications.

Select a job control or application from the list and click New Job Permissions.
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On the Function Permissions Properties window, edit the permission level as necessary. You can grant
or deny access to the public or specific users. In addition, you can specify submit, manage,
permission, display, copy, update, or delete permissions.

Set up a scheduling calendar:

Set up a calendar of selected days for scheduling a job or job group. This calendar can specify the dates
to be used for scheduling a job, or it can be used in conjunction with other schedules.

A scheduling calendar is a calendar of selected days that you can use for scheduling a job or job group.
You can display scheduling calendars, add a new scheduling calendar, add a new scheduling calendar
based on an existing one, or remove an existing calendar, provided it is not in use by a currently
scheduled job.

You can select a calendar and display its properties to make changes. When you select a calendar, the
details of the calendar are displayed under Details.

To set up a scheduling calendar, follow these steps:

Open Work Management from your iSeries Navigator window.
Right-click Advanced Job Scheduler and click Properties.

On the General page, click Calendars.

On the Scheduling Calendars page, click New.

Specify a Name.

In the Description field, specify text that describes the calendar.
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Choose a Reference calendar if applicable. This is a calendar that was previously set up, and its
properties will be applied to the new calendar as if you merged the two calendars. You will not have
reference calendars if this is your first time using the Advanced Job Scheduler.

8. Select the dates that you want to include on your calendar. You must specify whether each date you
have selected is for the current year or for every year in the Selected date field, before you can add
another date to the calendar. Otherwise, any date you select will be deselected when you click a
different date.

9. Specify if you want certain days of the week to be included on the calendar.

Set up a holiday calendar:

Set up a calendar for days that you do not want to allow processing for a scheduled job. Alternate days
can be specified for each exception day, or processing can be skipped completely for that day.

A holiday calendar is an exception calendar for days that you do not want to process an Advanced Job
Scheduler job. Alternate days can be specified for each exception day that you specify in a holiday
calendar. You can display holiday calendars, add a new holiday calendar, add a new holiday calendar

based on an existing one, or remove an existing calendar, provided it is not in use by a currently
scheduled job.

Predefined schedules can be used in holiday calendars. You can create a schedule THIRDFRI that has a
frequency of the third Friday of each month. When you use THIRDFRI in a holiday calendar, you cause

Management Central 51



all jobs that use this holiday calendar to not run on the third Friday of each month. One or more
schedules can be used in a holiday calendar. Dates that are generated by the schedule will be shown on
the calendar with a black border.

You can select a calendar and display its properties to make changes. When you select a calendar, the
details of the calendar are displayed under Details.

Set up a holiday calendar:

To set up a holiday calendar, follow these steps:
1. Expand Work Management from your iSeries Navigator window.
2. Right-click Advanced Job Scheduler and select Properties.

On the General page, click Calendars.

Click the Holiday Calendars tab.

Click New and type a name for the calendar.

In the Description field, specify text to describe the calendar.
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Choose a Reference calendar if applicable. This is a calendar that was previously set up, and its
properties will be applied to the new calendar as if you merged the two calendars. You will not have
reference calendars if this is your first time using the Advanced Job Scheduler.

8. Select the dates that you want to include on your calendar. You must specify whether each date you
have selected is for the current year or for every year in the Selected date field, before you can add
another date to the calendar. Otherwise, any date you select will be deselected when you click a
different date.

9. Select an alternate day for the job to run. You can choose the previous working day, next working
day, a specific date or not at all. To select a specific date, click Specific alternate date, and type the
date.

10. Select specific days of the week to be included on the calendar.
Add a schedule to a holiday calendar:

To add a holiday calendar to a scheduled job, follow these steps:

Expand Work Management from your iSeries Navigator window.

Right-click Advanced Job Scheduler and click Properties.

On the General page, click Calendars.

On the Holiday calendar page, select the holiday calendar and click Properties.
From the lower left hand corner of the tab, click Schedules.

Select the appropriate schedule and click Add.

To change the Alternate day, right-click the schedule from the Selected Schedules list and click the
correct Alternate Day.
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Set up a fiscal calendar:

Set up a fiscal calendar of selected days for scheduling a job or job group. Use this type of calendar if
you want to divide the fiscal year into periods other than months.

A fiscal calendar is a calendar of selected days that you can use for scheduling a job or job group. Use a
fiscal calendar to define a fiscal calendar that is unique to your business. You can specify the start and
end dates for each period in the fiscal year.

To set up a fiscal calendar, follow these steps:

1. Open Work Management from your iSeries Navigator window.

52 1BM Systems - iSeries: Systems Management Management Central



Right-click Advanced Job Scheduler and click Properties.

On the General window, click Calendars.

On the Fiscal Calendars page, click New.

Specify a Name.

In the Description field, type in text to describe the calendar.

Click New on the Fiscal Calendar Properties window to create a new entry.

Select a period and specify the start and end dates. You can specify up to 13 periods.
Click OK to save the fiscal calendar entry.
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Repeat steps 7 through 9 as necessary.
Specify a mail server to use for notification:

Set up a mail server to use for e-mail notification messages. A mail server is required if you want to send
e-mail notifications.

To set up the notification properties, follow these steps:
1. Open Work Management from your iSeries Navigator window.
Expand Advanced Job Scheduler.
Right-click Notification and click Properties.
Specify how many days to store messages. Specify a number in the Message retention field.
Specify an Outgoing mail server (SMTP). For example, SMTP.yourserver.com.
Specify a Port. The default port number is 25.
Specify an e-mail address in the Reply address field. All reply messages are sent to this address.
Select Yes or No in the Log send activity field. Send activity is used for problem determination.

Specify the Number of banner pages allowed. This is used in Report Distribution.
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Click OK to save the notification properties.
Set up multiple scheduling environments:

You can set up scheduling environments on the same system. By doing this, the original data library can
act as the active data library and the copied data library can be used for testing. Thus you have two
scheduling environments, one for testing and one that is the actual. In addition, the test data library can
serve as a backup if there is a system failure on the original system. This feature gives you added
protection if you create an error in the original data library because you have a backup copy of the data
library.

There are several reasons why you might want to set up multiple scheduling environments. You might
want to have a production version and a test version of the product running at the same time. This type
of environment allows you to test various job schedules before actually using them in the data library on
the production system. Or you might have a system that is the backup for one or more other systems in
which you can use a data-mirroring product to replicate the Advanced Job Scheduler data library
(QUSRIJS) from the source system into a library named differently. In this case, the data library is active
until there is a problem with the source system.

A scheduling environment is a duplicate of the QUSRIJS library except with different data. For instance
you can have another data library named QUSRIJSTST with all the objects as QUSRIJS. Each are

considered data libraries.

To set up a multiple scheduling environment, follow these steps:
1. Obtain a data library from a system
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To create a data library, you need to obtain a data library from a system. The following are three ways
that you can obtain a data library from the system:

* Save the data library from a system and restore it onto the production system.
* Duplicate the data library on the current system using the Copy Library (CPYLIB) command.

¢ Mirror a data library on the test system. These systems should be running the same version release
level.

Note: The copied, restored, or mirrored data library uses a different name than the original system.
2. Assign data libraries to users

After you obtain a test data library, add the data library to the Advanced Job Scheduler’s properties
and assign users to the data library. Therefore, when a user uses the Advanced Job Scheduler, the
changes that the user makes are stored in the data library assigned to the user.

3. Copy jobs from test data library to actual data library (optional)

If you are using a data library for testing purposes, you might want to copy the jobs from the test
data library to the actual data library in use. You only need to do this if you restored or copied a data
library in step 1 and you have jobs that you want to move to the actual data library in use. You do
not need to do this if you mirrored a data library from the actual system to a test system.

To copy jobs from one system’s data library to another, use the Copy Job using Job Scheduler
(CPYJOBJS) command. For more information about the specific parameters for this command, see the
online help.

Assign data libraries to users:

Specify what data library is associated with each user. A data library will contain all the objects found in
the QUSRIJS library. You can have any number of data libraries.

The data library stores any changes that the user does using the Advanced Job Scheduler. A data library
contains all the objects found in the QUSRIJS library. You can have an unlimited number of data libraries.

To assign data libraries to users, follow these steps:
1. Expand Work Management from your iSeries Navigator window.
2. Right-click Advanced Job Scheduler and click Properties.

3. On the Data Libraries window, click Add to specify a data library. The data libraries that are listed are
available to all users on the system.

On the Users window, click Add to add new users.

Specify a name.

Select a data library.

Click OK to add the user.

Click Properties to change the data library assigned to a user.
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With data libraries, you can set up multiple scheduling environments.
Manage the Advanced Job Scheduler:

The following information will help you manage the Advanced Job Scheduler. First you need to schedule
jobs using the Advanced Job Scheduler. Then, use the rest of the tasks to manage the jobs.

Create and schedule a job:

Schedule a job and specify the commands that are associated with the job. You can also specify starting
and ending commands to run a special version of a scheduled job.
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To create and schedule a new scheduled job, follow these steps:

1. Open Work Management from your iSeries Navigator window.
2. Right-click Advanced Job Scheduler.

3. Right-click Scheduled Jobs and click New Scheduled Job.

Create and schedule a job group:

Set up and schedule a series of jobs that run consecutively in a specified order. Jobs within a job group
require completion before the next job is submitted for processing.

Job groups are jobs that are grouped together to run consecutively in the order specified. A normal
completion is required for each job in the group before the next job in the group is submitted for
processing. If any job in the group does not complete normally, the processing stops for that group.

To create and schedule a new job group, follow these steps:

1. Open Work Management from your iSeries Navigator window.
2. Click Advanced Job Scheduler.

3. Right-click Job Groups and click New Job Group.

Refer to the online help for more information as you fill in details for the new job group.

Predefined schedules:

Create schedules that contain information needed to schedule a job or calculate exception dates within a
holiday calendar.

You can create schedules that contain information needed to schedule a job or calculate exception dates
within a holiday calendar.

For instance, you can create an ENDOFWEEK schedule that contains the day of the week to run, along
with any additional calendars. The ENDOFWEEK schedule can then be used by all the jobs that match
that scheduling frequency. You can access this feature only through iSeries Navigator.

You can use those same predefined schedules that are used in a job with your holiday calendars. You can
create a schedule THIRDEFRI that has a frequency of the third Friday of each month. When you use
THIRDERI in a holiday calendar, you cause all jobs that use this holiday calendar to not run on the third
Friday of each month. You can use one or more schedules in a holiday calendar. Dates that are generated
by the schedule will be shown on the calendar with a black border.

Setup a predefined schedule:

To set up a predefined schedule, follow these steps.

Expand Work Management from your iSeries Navigator window.
Right-click Advanced Job Scheduler and click Properties.

Click the Schedules tab.

Click New and type a name for the schedule.

Type a description for the schedule.
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Select the frequency and dates that you want to include in your schedule, as well as any additional
calendars.

Refer to the online help for more information as you fill in details for the new schedule.

Add a schedule to a scheduled job:
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To add a schedule to a scheduled job, follow these steps:

Open Work Management from your iSeries Navigator window.

Right-click Advanced Job Scheduler.

Click Scheduled Jobs to list jobs.

Right-click the scheduled job and click Properties.

Click the Schedule tab.

From the upper right hand corner of the tab, select the appropriate Schedule option.

I

Add a schedule to a holiday calendar:

A holiday calendar is an exception calendar for days that you do not want to process an Advanced Job
Scheduler job. Alternate days can be specified for each exception day that you specify in a holiday
calendar.

To add a schedule to a holiday calendar, follow these steps:

Expand Work Management from your iSeries Navigator window.

Right-click Advanced Job Scheduler and click Properties.

On the General page, click Holiday Calendars.

On the Holiday Calendars page, select the holiday calendar and click Properties.
From the lower left hand corner of the tab, click Schedules.

Select the appropriate schedule and click Add.

To change the Alternate day, right-click the schedule from the Selected Schedules list and click the
correct Alternate Day.
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Refer to the online help for more information.
Create a temporary scheduled job:

At times it might be necessary to run a scheduled job now or in the future in addition to its normal
schedule. Use the Submit Job using Job Scheduler (SBMJOBJS) command, option 7 from Work with Jobs
display, or the Run option from iSeries Navigator. It might also be necessary to process only a portion of
the commands in the command list when setting up this special run.

The SBMJOBJS command allows you to specify the Starting and Ending command sequences. For
instance, JOBA has 5 commands, sequences 10 through 50. You can specify on the SBMJOBJS command to
start with sequence 20 and end with sequence 40. This bypasses sequence 10 and 50.

iSeries Navigator allows you to select a starting command within the command list and an ending
command.

To run a special version of a scheduled job with iSeries Navigator, follow these steps:
Open Work Management from your iSeries Navigator window.

Right-click Advanced Job Scheduler.

Click Scheduled Jobs to list jobs.

Right-click on the scheduled job and click Run.

Specify whether to run the job now or in the future.
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Select the starting and ending commands.
Refer to the online help for more information as you fill in details for the new job.

Schedule job dependencies:
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Set up jobs or groups of jobs that are dependent on each other. You can select the type of dependency
that reflects how jobs are processed in your environment.

The Advanced Job Scheduler allows you to set up dependencies that reflect how jobs are processed in
your environment. Dependencies determine when a job or group of jobs can run. You can select to have
all dependencies met before a job can run, or you can have at least one dependency met before the job
can run. Dependencies include the following:

Job dependencies

Job dependencies refer to predecessor and successor relationships for jobs. Predecessor jobs are those
that must run before the successor job will run. A successor job is a job that runs after all the
predecessor jobs have been processed. There can be multiple successor jobs for a single predecessor job
as well as multiple predecessor jobs for a single successor job. In addition, you can specify that a
dependent job be skipped if its predecessors and successors run on a day that the dependent job is not
scheduled to run.

Active dependencies

Active dependencies are lists of jobs that cannot be active when the selected job is to be submitted. If
any of the jobs are active, the Advanced Job Scheduler will not let the specified job run. The selected
job will be delayed until all the jobs in the list are inactive.

Resource dependencies

Resource dependencies are based on several things. Each type that follows describes the areas that are
checked. Following are the types of resource dependencies:

File  The job is dependent on the existence or non-existence of a file and whether it meets the
specified allocation level to be processed. It can also check whether records are present before
the job is processed. For instance, JOBA can be set up so that it will only run when file ABC
exists, and the file can be allocated exclusively and if records are present in the file.

Object
The job is dependent on the existence or non-existence of a QSYS type object and whether it
meets the specified allocation level to be processed. For instance, JOBA can be set up so that it
will only run when data area XYZ exists. The job can also be dependent on the existence or
non-existence of an object found in the integrated file system. If the dependency is based on
any object in the path, end the integrated file system path with a forward slash "/".

Hardware configuration
The job is dependent on the existence or non-existence of a hardware configuration and its
status to be processed. For instance, JOBA can be set up so that it will only run when device
TAPO1 exists and has a status of Available.

Network file
The job is dependent on the status of a network file in order to be processed.

Subsystem
The job is dependent on the status of a subsystem in order to be processed.

To work with job dependencies, follow these steps:

1.
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Open Work Management from your iSeries Navigator window.
Expand Advanced Job Scheduler.

Click Scheduled Jobs.

Right-click the Job Name whose dependencies you want to work with.

Select one of the following: Job Dependencies, Active Dependencies or Resource Dependencies.
Refer to the online help for more information.

The Work Flow Manager:
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As of V5R4, the Work Flow Manager lets you define units of work that consist of automated or manual
steps. These units of work can then be scheduled or run interactively. The Work Flow Manager is located
in the Advanced Job Scheduler container in the iSeries Navigator interface.

Each step within the work flow can have one or more predecessor Advanced Job Scheduler jobs and one
or more successor Advanced Job Scheduler jobs. When a work flow starts, the first step is flagged to run.
When it completes, the next step is flagged to run, and so on.

The following are some additional considerations when using the Work Flow Manager:

* You can manually start a work flow at any step. When you do so, you bypass all previous steps in the
work flow.

* Automatic steps complete after all prior steps have completed. This includes all predecessor Advanced
Job Scheduler jobs.

* After a step completes, the successor Advanced Job Scheduler jobs are flagged to run.
* Manual steps can complete in any sequence as long as the step’s predecessor jobs have finished.

* You can mark completed manual steps as not complete and run them again as long as there are no
subsequent incomplete automatic steps.

* You can cause a step to wait until the job completes before notifying of the step’s completion by
specifying predecessor jobs that are the same as the successor jobs of the previous step.

* You can notify other users when a particular step starts, stops, did not start by a specific time, or is

taking too long. For example you can notify a user who is responsible for a particular manual step that
the previous automated steps have completed.

When you use work flows, the activity log displays when the work flow started, the steps that were run,
the status of automated steps (success or fail), when the work flow ended, and the final status of the
work flow.

Table 6. Work Flow Example

Work Flow PAYROLL

Scheduled Every Friday at 1:00 p.m.

Notification Clerk - Payroll work flow has started

Step 1 Automatic - Specifies a successor job to initialize payroll files
Step 2 Automatic:

* Specifies the successor job from step 1 as a predecessor job for this step

¢ Notifies Clerk that timecards can be entered

Step 3 Manual:

* Clerk completes after timecards are entered

* Specifies a successor job to process timecard files and print timecard report
* Notifies Supervisor if step is not completed within 120 minutes

Step 4 Automatic:

* Specifies successor job from previous step as a predecessor job
* No Successor jobs

* Notifies Clerk to check timecard report

Step 5 Manual:
* Clerk will complete after checking reports
* Specifies a successor job to process payroll
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Table 6. Work Flow Example (continued)
Work Flow PAYROLL

Step 6 Automatic:
* Specifies the successor job from previous step as a predecessor job
* No Successor jobs

* Notifies Clerk and Supervisor that payroll has completed

In this example the work flow PAYROLL starts every Friday at 1:00 p.m. A notification is sent to the
Clerk that the work flow has started.

Because Step 1 is automatic and does not have any predecessor jobs, it flags the successor job that
initializes the payroll files to run and then complete. Step 2 has the successor job for Step 1 as its
predecessor. Step 2 waits for the job that initializes the payroll files to complete. After it has completed,
Step 2 notifies the Clerk that he can enter timecards. There are no successor jobs to flag to run.

The Clerk manually completes Step 3 after all of the timecards are entered. The successor job that
processes the timecard file and prints a timecard report is flagged to run. As a precaution, the Supervisor
is notified if the step is not completed within 120 minutes. Because the predecessor job for Step 4 is the
successor for Step 3, Step 4 waits until the job that processes the timecard file and prints a timecard
report has completed.

After the job completes the Clerk is notified that the timecard report can be checked. There are no
successor jobs to flag to run. After the timecard report is checked, the Clerk manually completes Step 5.
The successor job that processes the payroll and produces the checks is flagged to run.

Because the predecessor job for Step 6 is the successor for Step 5, Step 6 waits until the job that processes
the payroll and produces the checks has completed. After the job completes, it notifies the Clerk and
Supervisor that Payroll has completed. The checks can now be printed and distributed.

For more detailed information about the Work Flow Manager see the online help.

Create a new work flow:

When you create a new work flow you will specify how the work flow is started, it’s maximum process
time, the task steps and their run sequence, scheduling, notification and documentation details.

To create a new work flow, do the following;:

* In iSeries Navigator expand My Connections > server > Work Management > Advanced Job
Scheduler ~» Right-click Work Flow Manager » New Work Flow.

The New Work Flow window appears.
For more information about how to complete the New Work Flow window see the online help.

Once you have set up your work flow, you can manage the work flow by right-clicking the work flow
name and clicking Work Flow Status.

Start a work flow:

When you start a work flow, you can choose whether you want the work flow to start on the first
sequence or on a specific sequence.

To start a work flow, do the following steps:
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1. From iSeries Navigator, expand Work Management » Advanced Job Scheduler > Work Flow
Manager » Right-click a work flow » Start. The Start Work Flow window appears.

2. Select if you want the work flow to start on the first sequence or on a specific sequence. If you select
to start at a sequence other than the first, all of the prior steps will be marked as completed.

For more information about the Start Work Flow window, see the online help.
Work with work flows:
You can control and monitor the work flow as it runs by using the Work Flow Status window.

You can access the Work Flow Status window by expanding My Connections - server > Work
Management > Advanced Job Scheduler » Work Flow Manager » Right-click a work flow ~» Status.

* The General window shows you the current status of the work flow.
* The Steps window provides you with a list of all steps currently defined to the work flow.

You can see whether a step has been defined to be either automated or manual and when the step has
started and ended.

— To mark a manual step as complete, select the correct step and check the Complete box.

— Manual steps can be marked completed in any order if all of the predecessor Advanced Job
Scheduler jobs for the step have completed.

— Manual steps can be marked as not completed if there are no Automatic steps completed further in
the list.

- A work flow can be started manually at any step. This bypasses all previous steps.
To refresh the list, click Refresh.
¢ The Documentation window shows you the documentation text for the work flow.

Monitor job activity for the Advanced Job Scheduler:

Use Advanced Job Scheduler to view a job or a job group’s history or status. You can also set up the
activity retention, which is how long you want to retain the activity records for a job.

Scheduled Job Activity:

The scheduled job activity allows you to specify how long the Advanced Job Scheduler activity records
are to be retained. The possible values are 1 to 999 days or occurrences. You can specify to keep activity
for a certain number of days, or for a certain number of occurrences per job.

The following details about a scheduled job are displayed:

* Name The name of the scheduled job.

¢ Group The name of the job group for the job.

* Sequence The sequence number of the job within the group, if the job is in a job group.
* Completion Status The status of the job.

 Started When the job started running.

* Ended When the job ended.

* Elapsed Time The amount of time in hours and minutes the job took to process.

Specify the activity retention:

To specify the activity retention, follow these steps:
1. Open Work Management from your iSeries Navigator window.
2. Expand Advanced Job Scheduler.
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3. Right-click Scheduled Job Activity and click Properties.
View the scheduled job activity details:

To view the scheduled job activity details, follow these steps:

1. Open Work Management from your iSeries Navigator window.
2. Expand Advanced Job Scheduler.

3. Double-click Scheduled Job Activity.

View the scheduled job activity for a specific job:

To view the scheduled job activity for a specific job, follow these steps:

1. Open Work Management from your iSeries Navigator window.

2. Expand Advanced Job Scheduler.

3. Click Scheduled jobs.

4. Right-click the Job Name whose activity you want to display and click Activity.

View the activity log details:

The activity log displays activity within the scheduler such as a job added, changed, or submitted.
Security violations, sequences processed by a scheduled job, and any errors received are displayed. The
dates and times for the previous activities are also displayed.

To view detailed message information, double-click a date and time. To view the activity log details,
follow these steps:

1. Open Work Management from your iSeries Navigator window.
2. Expand Advanced Job Scheduler.

3. Click Activity Log. The current day’s entries are shown. To change the selection criteria, select
Include from the Options menu.

View the activity log for a specific job:

To view the activity log for a specific job, follow these steps:

1. Open Work Management from your iSeries Navigator window.

2. Expand Advanced Job Scheduler.

3. Click Scheduled jobs.

4. Right-click the Job Name whose activity log you want to display and click Activity log.

You can also use the Last Run page of a job’s properties to view the progress of a job. Specify the Set
Step using Job Scheduler (SETSTP]S) command before or after a step in the CL program along with a
description that states the progress of the job. When the job reaches the SETSTPJS command in the
program, the associated description is displayed in the Last Run page and on your wireless device.

Monitor for messages with Advanced Job Scheduler:

Add message identifiers to any command within the command list of a job to monitor messages.

Each command in the command list of a job can have message identifiers that will be used for
monitoring. When the job runs and an error message is issued that matches one of the messages entered

for the selected command, the job logs the error but continues processing with the next command in the
list.
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If zeros are specified in either two or all four of the rightmost positions, such as ppmm00, a generic
message identifier is specified. For example, if CPF0000 is specified, all the CPF messages are monitored.

To add message identifiers to a command, follow these steps:
Open Work Management from your iSeries Navigator window.
Right-click Advanced Job Scheduler.

Click Scheduled Jobs to list jobs.

Right-click the scheduled job and click Properties.

Select the command from the list and click Properties.

Click Messages.
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Enter the message identifiers to monitor and click Add.
Create and work with local data area:

A local data area is a portion of space that is allocated for a job. Not all jobs use their local data area but
some do. Each command within a job has access to the job’s local data area. You might want to use a
local data area if you are scheduling a job that previously required you to manually specify additional
parameters. Use the local data area to specify the additional parameters so you do not need to manually
specify them each time the job starts.

To specify local data area information for a scheduled job, follow these steps:
1. Open Work Management from your iSeries Navigator window.

2. Expand Advanced Job Scheduler » Scheduled Jobs.

3. Right-click a job and click Properties.

4. Edit the Local Data Area window as necessary.

Refer to the online help for more information as you fill in details for the local data area.

Create and work with applications/job controls:

Applications are jobs that are grouped for processing. They are broader than job groups and do not
necessarily process sequentially. Jobs in applications can process simultaneously and one job does not
need to wait for another to process. All jobs within the application can be worked with and can have
their own set of job defaults. Job controls are the defaults assigned to a job as you add it to the job
scheduler as well as defaults used when the job is submitted.

Applications are jobs that have been grouped together for processing. For example, you might have a
series of jobs that you use for payroll that you want to group together for an accounting process.

Job Controls are the defaults assigned to a job as you add it to the job scheduler as well as defaults used
when the job is submitted. Job control defaults include such things as calendar, holiday calendar, job
queue, job description and so on.

You can display all the existing applications/job controls on your system. You can add a new
application/job control, add a new application/job control based on an existing one, or remove an
application/job control. You can also select an application/job control and display its properties to make
changes.

To create a new application/job control, follow these steps:

1. Expand Work Management from your iSeries Navigator window.
2. Right-click Advanced Job Scheduler and click Properties.

3. Click the Applications/Job Controls tab.
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Click New and type a name for the application.
Type a description for the application.

Choose the contacts for the application. Contacts are the names of users who are contacted if you
have a problem with a job within the application. You can specify up to 5 contacts per application.
You can also choose to add or remove contacts from the contact list.

You can type additional information to help you identify the application. The information is
associated with the new application. This information might be useful if any problems occur.

Work with notification:

This information describes how to use the notification function of Advanced Job Scheduler.

Within notification, you can perform a series of tasks. Notification allows you to specify recipient
properties and report distribution list properties. In addition, you can send e-mail messages and set up
an escalation list in case a recipient does not respond within a specified amount of time.

Before you can send an e-mail message, you need to specify a mail server to use for notification.

The following are highlights of the notification function of Advanced Job Scheduler:

Recipient

When scheduling a job, you can specify whether to send notification messages to specified
recipients. You can send a notification message if a job fails, completes successfully, or does not
start within a specified time limit. For each specified recipient, you need to define the recipient’s
properties. You can access the recipient’s properties by selecting Advanced Job Scheduler ~»
Notification » Recipients, and then select a recipient from the list of recipients.

Report distribution list

E-mail

Use a report distribution list to specify a list of spooled files that are eligible for distribution. Each
spooled file produced by a job is checked to see if a match exists within the spooled file list. If so,

the recipients associated with that spooled file receives a copy of the spooled file via e-mail, a
duplicate of the spooled file in their output queue, or both. You can access report distribution
lists by selecting Advanced Job Scheduler » Notification » Report distribution list.

You can send an e-mail message to any recipient that is defined in the list of recipients as well as
specific e-mail addresses. The recipient’s properties must specify an e-mail address to send the
message to. When sending an e-mail message, you can attach a spooled file. The spooled file can
be sent in PDF format. In addition, you can specify an escalation list to use if the intended
recipient does not respond within a specified period of time.

Specify a spooled file to attach to an e-mail:

To specify a spooled file to attach to an e-mail, complete the following:

1.

2.
3.
4.

Expand Basic Operations from your iSeries Navigator window.
Click Printer Output.

Right-click the spooled file and click Send via AJS.

Specify a recipient, subject, and message.

Note: This also can be done from Output Queues.

Escalation list

An escalation list specifies a list of recipients in descending order. The recipients are notified in
the order that they are listed. If the first recipient does not respond to the message, the message
is sent to the next recipient. This process continues until a response is made. To define an
escalation list, go to Advanced Job Scheduler » Notification » Escalation Lists.
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Stop a message from escalating:

To stop a message from escalating, complete the following;:

1. Expand Work Management from your iSeries Navigator window.
2. Click Advanced Job Scheduler » Notification » E-mail » Sent.

3. Right-click the escalating message and click Stop.

Note: To view only escalating messages, select View » Customize this view » Include from the
iSeries Navigator window. Then, in the Type field, select Escalating,.

Work with library lists:

Library lists are user-defined lists of libraries that are used by the Advanced Job Scheduler when a job is
processing.

A library list is a user-defined list of libraries that is used by the Advanced Job Scheduler job to search
for information it needs while processing. You can display library lists, add a new library list, add a new
library list based on an existing one, or remove a library list, provided that it is not being used by a
currently scheduled job.

You can select a list and display its properties to make changes. You can place up to 250 libraries on the
library list.

To add a new library list, follow these steps:

Open Work Management from your iSeries Navigator window.
Right-click Advanced Job Scheduler and click Properties.

Click the Library Lists tab.

Click New and type a name for the library list.

Type a description for the library list.

Click Browse to see a list of existing libraries, and click a library.
Click Add to add the list of selected libraries.
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Work with command variables:

A command variable (previously known as a parameter) is a variable you can store and use in jobs
submitted through the Advanced Job Scheduler. Examples of command variables include the beginning of
each month, a division number, a company number, and so on.

Command variables (previously known as parameters) are variables that you store in the Advanced Job
Scheduler and use in jobs submitted through the Advanced Job Scheduler. Command variables contain
information that will be replaced inside the command string of a scheduled job. Examples of command
variables include the beginning of each month, a company division number, a company number and so
on. You can display command variables, add a new command variable, add a new command variable

based on an existing one, or remove a command variable, provided it is not currently in use by a
scheduled job.

You can select an existing command variable and display its properties to make changes.

To add a new command variable, follow these steps:

1. Open Work Management from your iSeries Navigator window.
2. Right-click Advanced Job Scheduler and click Properties.

3. Click the Command Variables tab.

4. Click New and type a name for the command variable.
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5. Type a description for the command variable.
6. Type the length of the command variable. The length can range from 1 to 90.
7. Choose how you want to supply the replacement value:

a. Specify the data to use for the command variable. You use any character in this field. The number

of characters in the data cannot be greater than the length specified in the Length field.
Type a formula to calculate the date. (For examples, see the online Help.)
Type the program name that you use to retrieve the replacement value.

Type the library that you use to retrieve the replacement value.
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Work with Advanced Job Scheduler for Wireless:

Advanced Job Scheduler for Wireless works on two types of devices. A Wireless Markup Language
(WML) device is an Internet-ready cellular phone. A Hypertext Markup Language (HTML) is a PDA or
PC Web browser. Throughout this topic, the different devices are referred to as WML and HTML.

Hardware and software requirements:

Determine if you have all the necessary software and hardware to run Advanced Job Scheduler for
Wireless.

The following elements are required to run the Advanced Job Scheduler for Wireless:

 Licensed Program 5722-]S1 V5R3: The Advanced Job Scheduler product that includes Advanced Job
Scheduler for Wireless.

* A device to run the function
— An Internet-enabled telephone with a wireless internet service
— A PDA with a Web browser, a wireless modem, and a wireless internet service
— A traditional Web browser on a workstation
* A server running i5/0S® V5R3 or later in a TCP/IP network.
* A Web application server running on your central system, such as any of the following;:
— ASF Jakarta Tomcat Application server
— Any other application server that runs on the central system, having the capability to host servlets
¢ HTTP Server installed on the iSeries server

* Identify your HTTP server with the Advanced Job Scheduler wireless feature. To do this, connect to
your iSeries system that has Advanced Job Scheduler installed by using the character-based interface.
Then, specify the following command:

CALL QIJS/QIJSCINT
Select a device:
Choose devices that are compatible with Advanced Job Scheduler for Wireless.
Internet-ready telephones and wireless PDAs are a rapidly changing technology. They differ in screen
size, in look-and-feel, and in many other significant characteristics. The following sections help you
choose devices that are compatible with Advanced Job Scheduler for Wireless. Other wireless devices

may also be compatible if they support wireless Internet browsing, but the interaction may be different.

Internet-ready telephones Select an Internet-ready telephone to use with Advanced Job Scheduler for
Wireless.

PDAs Select a PDA to use with Advanced Job Scheduler for Wireless.

Management Central

Choose whether you want the replacement value retrieved from the system operator at run time.
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PCs You can also use a traditional Web browser with Advanced Job Scheduler for Wireless.
Configure your wireless environment:

Modify your web application server and firewall configuration so that Advanced Job Scheduler for
Wireless will run properly.

Before you begin using Advanced Job Scheduler for Wireless, ensure that you have properly configured
or set up the following items:

1. Configure your Web application server Set up Advanced Job Scheduler for Wireless to run using an
ASF Jakarta Tomcat servlet engine. These instructions specify how to create and start your Web
application server. In addition, it specifies a program that you need to run before working with the
wireless function of Advanced Job Server.

2. Configure your firewall This topic describes how to configure your firewall for iSeries Navigator for
Wireless. These configuration steps also apply to Advanced Job Scheduler for Wireless. View this topic
to determine if you need to modify your firewall to gain access to systems from a wireless device.

3. Select a language The default language is set to English, but you can configure your device to display
your language of choice.

After you have completed these steps, you are ready to connect to your server and begin using Advanced
Job Scheduler for Wireless.

Configure your Web application server:

Before working with Advanced Job Scheduler for Wireless, you must start and configure the Web
application server. The following procedures set up an ASF Tomcat servlet engine for HTTP Server
(powered by Apache) to run Advanced Job Scheduler for Wireless.

Requirements

Before you begin, you must have QSECOFR authority and the following installed:
« IBM ® HTTP Server (5722-DG1)

Note: The following instructions will create a new instance of an HTTP Server; you cannot use the
following instructions to set up Advanced Job Scheduler on an existing HTTP Server.

Initialize Advanced Job Scheduler for Wireless on the HTTP Server

Running the following command will add the Advanced Job Scheduler for Wireless servlet to the Apache
Software Foundation Jakarta Tomcat servlet engine. It will also set up an IBM HTTP Server (powered by
Apache) named Advanced Job SchedulerP that listens for requests on port 8210.

Before working with Advanced Job Scheduler for Wireless, you need to initialize the Advanced Job
Scheduler for Wireless on the HTTP server instance on your iSeries system. To do this, specify the
following command from the character-based interface. This command runs a program that is supplied
with the iSeries system.

CALL QIJS/QIJSCINT
After you configure your Web application server and initialize the Advanced Job Scheduler instance on
the Web application server, you can continue configuring your Advanced Job Scheduler wireless

environment.

Configure your firewall:
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Determine if you need to modify your firewall to gain access to systems from a wireless device.

When you use iSeries Navigator for Wireless, you will be accessing at least one of your systems from the
Internet. If you access any of your systems from the Internet today, you probably have a firewall set up
to prevent unauthorized access. Depending on your firewall configuration, you may have to modify your
firewall setup to run iSeries Navigator for Wireless.

If you have never accessed your systems from the Internet and do not have a firewall set up, the
following IBM Redbook provides strategies for doing so in the chapters about screened host architecture
and screened subnet architecture. See AS/400® Internet Security Scenarios: A Practical Approach®.

Select a language:

When you connect to Advanced Job Scheduler for wireless, you can specify which language to use. If you
do not want to specify a specific language, you can proceed to connecting to your iSeries.

To specify a language, use the following URL:

host. domain: port/servlet/ A]JSPervasive?Ing= lang
* host: The host name of the system that contains the product.
* domain: The domain where the host is located.
 port: The port that the instance of the Web server is listening to

* lang: The 2-character identifier for the language. The following is a list of available languages and their
2-character identifiers. (ar: Arabic de: German en: English es: Spanish fr: French it: Italian ja: Japanese)

Now you can begin working with Advanced Job Scheduler for Wireless.

Connect to your iSeries:

Connect to your iSeries that contains the Advanced Job Scheduler product using your wireless device.
To begin using Advanced Job Scheduler for Wireless, specify the URL of your iSeries into your wireless
device. When pointing your device to the URL on your iSeries, use the following format. Ensure that the
end of the URL (/servlet/Advanced Job SchedulerPervasive) is typed exactly as shown:

host. domain: port/servlet/ Advanced Job SchedulerPervasive

host: The host name of the iSeries. domain: The domain where the iSeries is located. port: The port
that the instance of the Web server is listening to. Default is 8210.

To specify a specific language to use, see Select a language.
Internet-ready telephone and PDA browser layout

If you have successfully connected to the Advanced Job Scheduler for Wireless feature on your iSeries,
the initial display contains summary information about your Internet-ready telephone or PDA. The
summary specifies how current the information is, how many scheduled jobs exist, how many activity
entries exist, and options to check the status of the job monitor or send a message to a recipient. In
addition, the summary provides an overall status of OK or Attention at the top of the display. If
Attention is specified, a job has a message that needs more attention. The job that requires attention
contains an exclamation point.

Traditional browser layout
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The traditional browser layout is exactly the same as the Internet-ready telephone and PDA display.
However, the amount of content is smaller than the size of the display. Therefore, you can reduce the size
of the Web browser to allow for more space to work with other applications while keeping the Advanced
Job Scheduler for Wireless Web browser open. In addition, if you are using a traditional Internet browser
on your PC, you can select to Show all from the Advanced Job Scheduler main menu. Then, you can
view more content in a single Web page.

After you have successfully connected to your system, you might want to customize your connection.
Customize your connection:

Using your wireless device, you can customize the interface to your specific needs. For example, you
might want to view only certain jobs and specify not to view the job’s group name. You also might not
want to access the list of scheduled activity. The Customize page on your wireless device allows you to

filter jobs as well as change display preferences.

There are many ways to customize your connection whether you are using a PC, PDA, or Internet-ready

telephone. To take advantage of these features, see the |[Advanced Job Scheduler] product Web site. -l&

Manage Advanced Job Scheduler for Wireless:

Use your wireless device to work with Advanced Job Scheduler. The following features are available
using a wireless device:

View active, held, and pending jobs
You can view a list of the regular jobs (Advanced Job Scheduler jobs) or Management Central
jobs that have the active, held, or pending state. You can further customize the jobs displayed by
sorting by job type, name, or time. In addition, you can specify which data library contains the
data for jobs and activities.

View job dependencies
You can view the predecessor and successor jobs for a particular job. A successor is a job that is
dependent on one or more jobs (predecessors) to run. In turn, a successor job can be a
predecessor job to other successor jobs.

Display messages
If a job has a message waiting for it, you can view the message text and reply to the message
using your wireless device.

Start jobs
You can use your wireless device to submit jobs. The options you can specify when submitting a
job depend on what wireless device you use.

Work with Advanced Job Scheduler activity
You can interact with your Advanced Job Scheduler activity from a wireless device. Each activity
has different options based on the status of the activity entry.

Internationalization
Advanced Job Scheduler for Wireless uses the country and language codes associated with your
iSeries™ Java™ Virtual Machine to determine what language and date/time formatting to use
on your wireless devices. If the Java Virtual Machine defaults are not the codes you want to use,
you can easily change it. See the online help for more details.

See the online help for more details on performing specific tasks.
Troubleshoot the Advanced Job Scheduler:

When a job does not run at the scheduled time, find out what you can do.
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To troubleshoot the Advanced Job Scheduler, first view the[Job Scheduler frequently asked qu1es’cior1:§.|-.l5r
Web page. Read about commonly asked questions that identify how to do certain functions with
Advanced Job Scheduler.

Also, here are a list of items that you can review when a job does not run at the scheduled time:

Current® fix level
The first thing you should verify is that your fixes are current. When you request fixes, be sure to
request a list of all fixes. Not all fixes are included in the [cumulative packages}

Check job monitor

* Job QIJSSCD should be active in the QSYSWRK subsystem. If it is not, process the Start Job
Scheduler (STR]S) command.

* The job monitor can be in a loop if the status of the job is RUN for over ten minutes. If it is in
a loop, end the job with *IMMED, and start the job monitor again (STRJS).

¢ If there is a message to answer, reply with a C (Cancel). The job monitor will go into a
90-second delay and then start monitoring again. Print the job log for the monitor job. This will
contain the error messages.

Check the Advanced Job Scheduler log
Process the Display Log for Job Scheduler (DSPLOG]JS) command for the job. Press F18 to go to
the end of the list. Entries exist to explain why the job did not run. Examples of the entries
include a resource failure, active or job dependency situation, or submission error.

Dependency on another job
If the job is dependent on another job, take option 10 from the Work with Jobs display to display
job dependencies. Press F8 to list all predecessor jobs. A dependent job cannot run unless all the
predecessor jobs show *YES in the Complete column.

Track a job’s progress
If a job is not functioning properly, you can use the Set Step using Job Scheduler (SETSTP]S)
command before or after a step in your CL program to help determine what the problem is.
Specify the command along with description text in your CL program. Use this command as
many times as necessary. The text description that is associated with the current command is
displayed in the Command step field on the Last Run page of the scheduled job properties. In
addition, you can view the Command step field on the Status window of an active job. The
Command step field is automatically updated every time the job encounters the SETSTPJS
command. Use this command to help determine the progress of a job.

Collecting these data samples will help in your problem analysis:

Error message conditions
Print the job log for the interactive session, monitor job or scheduled job, depending where the
error occurred.

Job schedule date is not correct
Process the DSPJOBJS command for the job with OUTPUT(*PRINT). Print a calendar report if a
calendar is used within the job. Print a holiday calendar report if a holiday calendar is used
within the job. Press the Print key to print the display of each fiscal calendar entry for the fiscal
calendar used within the job.

Advanced Job Scheduler log
Always print the Advanced Job Scheduler log for the time period in question.

Files QAIJSMST and QAIJSHST
Files QAIJSMST and QAIJSHST in library QUSRIJS might need to be journaled before trying to
reproduce the problem. Also, the QUSRIJS library may be needed by IBM support.
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Related information for Management Central

Listed here are the IBM, Web sites, and information center topics that relate to the Management Central
topic.

Web sites

In addition to these resources, you can find more information about Management Central tasks and
topics in the detailed task help in iSeries Navigator.

For more information about these and other Management Central tasks and topics, refer to the detailed
task help that is available from the iSeries Navigator window. Click Help from the menu bar and select

iSeries Navigator overview » Management Central.

You can use a variety of Web sites to find more information about Management Central. These include:

* [iSeries Navigator]| -l&

iSeries Navigator provides a wide variety of tools to simplify eServer'  management. Go to the iSeries
Navigator home page to find information about iSeries Navigator, including functional release
overviews, news about technical conferences, and other hot topics. You'll find links to a variety of
information including release updates, functional overviews, FAQs, and more.

* [iSeries Navigator for Wireless| -lé

The iSeries Navigator for Wireless Web page gives you more information about this exciting solution
for pervasive computing.

Other information

You will find links from various places in the Management Central topic to other Information Center
topics that relate to Management Central.

* [Single signo

If you have been looking for a way to simplify the task of managing user profiles on the eServer
server, single signon may be the answer for you. This information presents a single signon solution for
the eServer server, which uses the technology of Enterprise Identity Mapping (EIM), paired with the
eServer network authentication service. The single signon solution simplifies the task of managing user
profiles, while reducing the number of signons that a user must perform to access multiple applications
and servers.

This topic includes a scenario that demonstrates how to configure an entire system group to participate
in a single signon environment. After administrators complete the scenario for propagating a single
signon configuration across multiple systems, they can do the necessary configuration so that the entire
system group can participate in the single signon environment.

+ [Configuring Management Central Connections for Firewall Environments|

This report details Management Central connections and the configurations required to enable
Management Central to operate within a variety of firewall environments. As a distributed
management application, Management Central requires numerous incoming and outgoing TCP/IP
socket connections. In contrast, the basic premise of a firewall is to restrict/modify incoming and
outgoing connections.

 For information about installing and getting started with iSeries Navigator, be sure to see the
topic in the Information Center.

Saving PDF files

To save a PDF on your workstation for viewing or printing:
1. Right-click the PDF in your browser (right-click the link above).
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2. Click the option that saves the PDF locally.
3. Navigate to the directory in which you want to save the PDFE.
4. Click Save.

Downloading Adobe Reader

You need Adobe Reader installed on your system to view or print these PDFs. You can download a free

copy from the [Adobe Web site| (www.adobe.com /products/acrobat/ readstep.htrnl)'-lijr .

Code license and disclaimer information

IBM grants you a nonexclusive copyright license to use all programming code examples from which you
can generate similar function tailored to your own specific needs.

SUBJECT TO ANY STATUTORY WARRANTIES WHICH CANNOT BE EXCLUDED, IBM, ITS
PROGRAM DEVELOPERS AND SUPPLIERS MAKE NO WARRANTIES OR CONDITIONS EITHER
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR
CONDITIONS OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND
NON-INFRINGEMENT, REGARDING THE PROGRAM OR TECHNICAL SUPPORT, IF ANY.

UNDER NO CIRCUMSTANCES IS IBM, ITS PROGRAM DEVELOPERS OR SUPPLIERS LIABLE FOR
ANY OF THE FOLLOWING, EVEN IF INFORMED OF THEIR POSSIBILITY:

1. LOSS OF OR DAMAGE TO, DATA;

2. DIRECT, SPECIAL, INCIDENTAL, OR INDIRECT DAMAGES, OR FOR ANY ECONOMIC
CONSEQUENTIAL DAMAGES; OR

3. LOST PROFITS, BUSINESS, REVENUE, GOODWILL, OR ANTICIPATED SAVINGS.
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF DIRECT,

INCIDENTAL, OR CONSEQUENTIAL DAMAGES, SO SOME OR ALL OF THE ABOVE LIMITATIONS
OR EXCLUSIONS MAY NOT APPLY TO YOU.
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Appendix. Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
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Software Interoperability Coordinator, Department YBWA
3605 Highway 52 N

Rochester, MN 55901

US.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this information and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement,
IBM License Agreement for Machine Code, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. _enter the year or years_. All rights reserved.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

Trademarks

The following terms are trademarks of International Business Machines Corporation in the United States,
other countries, or both:
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AIX

AIX 5L
e(logo)server
eServer
i5/0S

IBM

iSeries
pSeries
xSeries
zSeries

Intel, Intel Inside (logos), MMX, and Pentium are trademarks of Intel Corporation in the United States,
other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.
UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, and service names may be trademarks or service marks of others.

Terms and conditions

Permissions for the use of these publications is granted subject to the following terms and conditions.

Personal Use: You may reproduce these publications for your personal, noncommercial use provided that
all proprietary notices are preserved. You may not distribute, display or make derivative works of these
publications, or any portion thereof, without the express consent of IBM.

Commercial Use: You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make derivative works of
these publications, or reproduce, distribute or display these publications or any portion thereof outside
your enterprise, without the express consent of IBM.

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either
express or implied, to the publications or any information, data, software or other intellectual property
contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of
the publications is detrimental to its interest or, as determined by IBM, the above instructions are not
being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable
laws and regulations, including all United States export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE
PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.
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